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Preface

How to Use This Guide

Purpose of This
Guide

The Applied Biosystems SequencePro®  Data Analysis Application 
v2.1 User Guide  provides procedural and reference information 
related to analyzing data from the PROCISE® Protein Sequencing 
Systems. It describes how to use the software application to set up 
preferences, view data and select different analysis parameters.

Audience This guide is intended for novice and experienced 49X PROCISE 
Protein Sequencing Systems users who use the system for obtaining 
N-terminal (PROCISE® or PROCISE® cLC protein sequencer) or 
C-terminal (PROCISE® C protein sequencer) protein sequencing data. 

Assumptions This guide assumes that your PROCISE Protein Sequencing System 
has been installed by an Applied Biosystems technical representative 
and that the latest PROCISE operation software is loaded on the 
system.

This guide also assumes that you have a working knowledge of the 
Windows® 2000 operating system.

Text Conventions This guide uses the following conventions: 

• Bold indicates user action. For example:

Type 0, then press Enter for each of the remaining fields.

• Italic text indicates new or important words and is also used for 
emphasis. For example:

Before analyzing, always prepare fresh matrix.

• A right arrow bracket (>) separates successive commands you 
select from a drop-down or shortcut menu. For example:

Select File > Open > Spot Set.
Right-click the sample row, then select View Filter > View All 
Runs.



DRAFT
September 1, 2005 4:04 pm, Preface.fm

Preface

x SequencePro®  Data Analysis Application v2.1 User Guide 

User Attention
Words

Two user attention words appear in Applied Biosystems user 
documentation. Each word implies a particular level of observation 
or action as described below:

Note: Provides information that may be of interest or help but is not 
critical to the use of the product.

IMPORTANT! Provides information that is necessary for proper 
instrument operation, accurate chemistry kit use, or safe use of a 
chemical.

Examples of the user attention words appear below:

Note: The size of the column affects the run time.

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection to the database, you 
need a valid Oracle user ID and password.

IMPORTANT! You must create a separate Sample Entry Spreadsheet 
for each 96-well microtiter plate.

How to Obtain More Information

Related
Documentation

The following related documents are shipped with the system:

• PROCISE®, PROCISE cLC® and PROCISE® C Protein 
Sequencing Systems User Guide (P/N  4340645) – Describes 
the PROCISE, PROCISE cLC and PROCISE C protein sequencer 
hardware and software and provides information on preparing 
samples, maintaining, and troubleshooting the system.

• PROCISE Online Help – Describes the PROCISE software and 
provides explanations for common tasks. 

Note: For additional documentation, see “How to Obtain Services 
and Support” on page xi.

Send Us Your
Comments

Applied Biosystems welcomes your comments and suggestions for 
improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com
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How to Obtain Services and Support
For the latest services and support information for all locations, go to 
http://www.appliedbiosystems.com, then click the link for Services 
and Support.

At the Services and Support page, you can:

• Search through frequently asked questions (FAQs)

• Submit a question directly to Technical Support

• Order Applied Biosystems user documents, MSDSs, certificates 
of analysis, and other related documents

• Download PDF documents

• Obtain information about customer training

• Download software updates and patches

In addition, the Services and Support page provides access to 
worldwide telephone and fax numbers to contact Applied Biosystems 
Technical Support and Sales facilities.
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1Overview 1

About This
Chapter

This chapter describes the computer specifications to install and use 
the SequencePro® Data Analysis Application v2.1 software, user 
management features, an overview of the SequencePro software, and 
a flow diagram of a typical session using the software.

In This Chapter This chapter contains the following topics:

Computer System Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . .1-2

Installing SequencePro Software on Windows-Based Platforms . .1-2

Registering SequencePro Software . . . . . . . . . . . . . . . . . . . . . . . . .1-2

About PROCISE and SequencePro User Management Features. . . .1-3

About the SequencePro Software . . . . . . . . . . . . . . . . . . . . . . . . . .1-9

SequencePro Software Flow Diagram  . . . . . . . . . . . . . . . . . . . . . .1-9

Starting the SequencePro Software . . . . . . . . . . . . . . . . . . . . . . . .1-10
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Computer System Specifications

Specifications The following table lists the computer subsystem specifications:

Installing SequencePro Software on Windows-
Based Platforms

Procedure To install the SequencePro software:

1. Insert the CD-ROM in the drive.

2. Double-click the Installer icon. A Setup wizard guides you 
through the installation.

3. Quit the Installer when procedure is complete. Remove and store 
the CD-ROM.

Registering SequencePro Software

License and
Warranty

Before you begin, please read Appendix B, “Software Warranty 
Information.” It explains your rights and responsibilities regarding 
this software.

Subsystem PC

Platform Pentium or higher-based personal computer

Operating System Windows® 2000, Windows® XP

RAM 128 MB minimum 
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About PROCISE and SequencePro User 
Management Features

Modes The operation of SequencePro software is determined by the 
installation of PROCISE® PC 2.1 software. PROCISE software can be 
installed in two different modes:

• Regulatory 

• Non-regulatory mode

The regulatory mode offers a set of user management features that 
allow an administrator to control access to the features of PROCISE 
and SequencePro software. The PROCISE software administrator can:

• Create new users 

• Create and edit user types 

• Manage individual user access to specific screens or capabilities 

• Deactivate users 

The SequencePro software administrator can:

• Create 

• Edit 

• Deactivate users 

When you install the software in regulatory mode, you are required to 
log in to each software application with an ID and password. In the 
regulatory mode, the PROCISE Event Log records your name along 
with the time and date of the event. In addition, creating or editing 
cycles, procedures and methods requires verification (re-entry) of 
user ID and password in order for changes to be saved. The PROCISE 
Event Log information and the Chemical Log information is 
transferred to the SequencePro software data file. 

When you open the PROCISE software in the regulatory mode, you 
can view the Monitor Run and the Event Log screens without a user 
log-in. Access to any other screens or any of the functionality of the 
PROCISE software requires the user to log in. You must log in to 
access SequencePro software features.
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Regulatory Mode
Log In

In the regulatory mode, all users must log in for access to 
SequencePro software functions. 

To log in:

1. Click on the SequencePro software shortcut to open the 
SequencePro Login dialog box.

2. Enter your user ID and password and press OK. All 
SequencePro software features will now be accessible. 

The initial user ID and password combination for all users is created 
by your SequencePro software administrator. If a password is lost or 
forgotten, your administrator will create a new initial password for 
the user. 

Note: After three failed attempts to log in to the software, the user 
ID/ password combination will be inactivated and your administrator 
will need to create a new initial password.

Changing Initial
Passwords

The first time you log in to the SequencePro software, you must 
create a new password. This password should be known only to the 
user and not shared with your administrator or any other user. 

To change the password:

1. Log in to the SequencePro software to access the Change 
Password dialog box.
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2. In the Change Password pop up menu, enter the:

a. Administrator-created initial password.

b. Enter the new password twice, once in the New Password 
field and once in the Confirm Password field and 

3. Click OK. 

About Passwords • Passwords must be a minimum of 6 and maximum of 15 
alphanumeric characters. 

• SequencePro software passwords will expire in nine months or 
less if a shorter expiration is set by the SequencePro software 
administrator. The SequencePro software will begin prompting 
the user to create a new password two weeks prior to expiration 
of the current password. 

• If the password expires before a new password is created, the 
SequencePro software administrator will need to create a new 
initial password for the user.

Changing
Subsequent
Passwords

After initial login, you have access to the change password menu. Go 
to the User Management pull-down menu and select Change 
Password. The dialog box shown in the preceding procedure appears; 
the password may be changed in the same manner as the initial 
password. 

Note: For users without administrative rights, the other user 
management selections will be unavailable.
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About Timeout
Intervals

All users have a timeout setting. This feature automatically logs you 
out after a specified period of inactivity. The length of the timeout 
interval is the amount of idle time allowed before the software will 
log out a user and is set by the SequencePro software administrator. If 
you are away from the system for longer than the timeout interval, the 
software will log you out and the you will need to log on again to 
resume the session.

Managing Users The SequencePro software administrator has access to the user 
management feature of the SequencePro software. The administrator 
can create new users, set password expiration and screen timeout 
duration, and deactivate users.

The Create/ Maintain User dialog box allows your administrator to 
manage user access to the SequencePro software. From the User 
Management pull down, select Create/Maintain User and the 
Maintain User dialog box appears.

 

All fields will be grayed out except the Password Expiry and the 
Timeout Interval. 

Note: The default values are six months for password expiration and 
five minutes for the timeout interval. Custom default values can be 
set at this point or these values can be set individually as each user is 
set up.
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Creating a New
User

To create a new user:

1. Click the Add New button on the Maintain User dialog box to 
activate all the entry fields.

2. Enter a Login ID for the new user. The Login ID can be any 
combination of 3 to 15 alphanumeric characters. 

3. Enter the full legal name of the user associated with the Login 
ID. The user's full name will be recorded with all actions 
reported to the Event Log during the session.

4. Set and confirm an initial password for the user. Passwords must 
be a minimum of 6 and maximum of 15 alphanumeric 
characters.

5. Set password expiration and timeout interval if values other than 
the default values are required.

6. Click Save Changes to store the new user. Click Revert 
Changes to clear all entries.

Changing User’s
Password

To change the password for a user:

1. Highlight the user from the list at the left of the Maintain User 
dialog box (shown preceding). 

2. Click Reset Password and enter and confirm the new initial 
password. Passwords must be a minimum of 6 and maximum of 
15 alphanumeric characters.
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Inactivating a
User

To inactivate a user:

1. Highlight the user from the list at the left of the screen. 

2. Click Delete. A pop up appears requiring confirmation.

3. Click Yes. The user is marked as inactivated in the list but not 
removed from the list. 

Note: The default administrator cannot be inactivated.
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About the SequencePro Software
The SequencePro software analyzes protein data obtained from 
PROCISE®, PROCISE® cLC, and PROCISE® C Protein Sequencing 
Systems. The software runs on IBM-compatible computers running 
the Microsoft Windows® 2000 operating system.

SequencePro Software Flow Diagram

Flow Diagram The following flow diagram shows a typical SequencePro software 
session.

This manual takes you through each of the steps in this flow diagram.

Start

Set 
Application 
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Create 
Another 
Method 
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Create a 
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Data File 
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Starting the SequencePro Software

Opening the
SequencePro

Software

To open the SequencePro software:

1. Double-click the SequencePro software icon, or select Program 
Files and then select SequencePro. 

The splash screen appears for a few seconds.

The splash screen is replaced by the Select a task dialog box.

Note: The Select a task dialog box does not appear if an 
acquisition is in progress.

2. Click a button in the Select a task dialog box to:

• Open an existing file

• View or modify the Data Dictionary
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2Setting Preferences and Using 
Toolbars 2

About This
Chapter

This chapter discusses how to set the preferences for SequencePro® 
Data Analysis Application v2.1 and information about the various 
pages and toolbars in the application.

In This Chapter This chapter contains the following topics:

Setting SequencePro Software Preferences. . . . . . . . . . . . . . . . . . .2-2

Using the Laboratory Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-4

Using the File Locations Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-6

Using the Chromatogram Page . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-8

Using the Peak Tables Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-10

Using the Sequence Tables Page . . . . . . . . . . . . . . . . . . . . . . . . . .2-12

Using the Reports Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-14

Setting Toolbar Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-16

Using the Standard Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-18

Using the Zoom Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-19

Using the Windows Toolbar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-20

Using the Events Toolbar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-21
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Setting SequencePro Software Preferences

Description Specify software preferences the first time you use the SequencePro 
software. This entails:

• Naming the laboratory and all users

• Defining acquisition and chromatogram settings

• Setting options for formatting chromatograms, peak lists, reports, 
and sequence tables 

In this process, you also set the on-screen Toolbar options.

Note: Preferences are editable at any time.

Flow Diagram The following flow diagram illustrates setting application 
preferences.

Start

Set SequencePro 
Preferences

Set Toolbar 
Options

Done

Using the Laboratory Page

Using the File 
Locations Page

Using the 
Chromatogram Page

Using the Peak 
Tables Page

Using the Sequence 
Tables Page

Using the Reports Page

Using the Standard Toolbar

Using the Zoom Toolbar

Using the Windows Toolbar

Using the Events Toolbar
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Setting
Preferences

To set preferences:

1. From the View menu, select Preferences to open the 
Preferences dialog box.

2. Click each of the following tabs in the SequencePro Preferences 
dialog box and type in the required information on each page. 

3. Click a new tab after you complete each page.

Note: These pages may be completed in any order.

4. Click OK in the SequencePro Preferences dialog box when you 
have completed entering information in all of the pages.

Page See Page

Laboratory page 2-4

File Locations page 2-6

Chromatogram page 2-8

Peak Tables page 2-10

Sequence Tables page 2-12

Reports page 2-14
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Using the Laboratory Page

Description The Laboratory page allows you to enter information about your 
laboratory and the names of all of the sequencer operators. The 
information entered here is automatically included in all new data 
files.

Setting
Laboratory Page

Options

To set the Laboratory options:

1. With the SequencePro Preferences dialog box displayed, click 
the Laboratory tab to open the Laboratory page.
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2. Type the name and address of the laboratory in their respective 
fields.

3. Click another tab or, if you are done, click OK in the 
SequencePro Preferences dialog box.

If you want to... Then...

add an operator’s 
name

1. Click the New Operator button to 
open the Operator Information dialog 
box.

2. Enter the name of the new operator in 
the Name field, and then click OK. 
The OK button will not be activated 
unless data is entered in the Name 
box.

edit an operator’s 
name

1. Select the name you want to edit.

2. Click the Edit Operator button.

3. Type your edits in the Operator 
Information dialog box, then click OK.

delete an 
operator’s name

1. Select the name of the operator you 
want to delete.

2. Click the Delete Operator button.
The operator’s name is deleted from 
the list.
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Using the File Locations Page

Description The File Locations page allows you to enter information about the 
default folders for opening and saving method and sample files.

Setting File
Locations

To set the File Locations:

1. With the SequencePro Preferences dialog box displayed, click 
the File Locations tab to open the File Locations page.

2. To select the default folder for Method templates:

a. Click the Browse icon to the right of the field labeled 
Default folder for Methods. A dialog box opens, allowing 
you to choose a directory.

b. Use the dialog box to select the folder you want to use as 
the default folder for the Method template, then click OK.

The path to this folder now appears in the default folder for 
Methods field on the File Locations page. 

Note: You cannot directly edit this field. To change the default 
folder, repeat steps a and b.
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3. To select the default folder for data files:

a. Click the Browse icon to the right of the field labeled 
Default folder for Data.

A dialog box opens, allowing you to choose a directory.

b. Use the dialog box to select the folder you want to use as 
the default folder for the data file, then click OK.

The path to this folder now appears in the default folder for Data 
Field in the File Locations page.

Note: You cannot directly edit this field. To change the default 
folder, repeat steps a and b.

4. Click another tab or, if you are done, click OK in the 
SequencePro Preferences dialog box.
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Using the Chromatogram Page

Description The Chromatogram page allows you to specify the default display 
settings for chromatograms.

Defining
Chromatogram

Options

To define the Chromatograms Options:

1. In the SequencePro Preferences dialog box, click the 
Chromatograms tab to open the Chromatogram page.

2. In the Chromatogram section:

Use the... To...

Time Axis and mV 
Axis check boxes

select the parameters that you want to 
appear.

Plot Colors button select the plot colors for chromatograms.

Line Width text box enter the line width you want for the 
chromatogram.
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3. In the Peak Labels section:

4. In the Integration Events and Baseline section:

5. Click another tab or, if you are done, click OK in the 
SequencePro Preferences dialog box.

Use the... To...

Name pull-down 
menu

select where you want the amino acid 
name to appear (On or Off).

Letter pull-down 
menu

select how you want the amino acid name 
to appear (1- Letter, 3-Letter, or Full 
Name).

Font button select the font for peak labels.

Ret. Time 
pull-down menu

display the retention time above the label 
(On or Off).

Check boxes select the parameters you want to appear 
in the chromatogram. Parameters include:

• Baseline
• Drop Lines
• Comments (indicated by yellow box 

above peak in Chromatogram view 
and by footnote in Report view.)

• Peak Marks
• RT Windows
• Called Amino Acid

Use the... To...

Events pull-down 
menu

select how you want to indicate the 
events information (Code, Full Text, or 
Off).

Font button select a font, font style, and color, as in 
step 3.
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Using the Peak Tables Page

Description The Peak Tables page allows you to enter the default display settings 
for peak tables.

Setting Peak
Table Options

To set the Peak Tables options:

1. With the SequencePro Preferences dialog box displayed, click 
the Peak Tables tab to open the Peak Tables page.

2. In the Peak Table Columns section, you can:

Use the... To...

AA Names pull-down menu select the Full Name, 1-Letter, 
or 3-Letter amino acid 
designation.

Font button select the font for the peak 
tables.
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3. Click another tab or, if you are done, click OK in the 
SequencePro Preferences dialog box.

Hide Unidentified Peaks check 
box

cancel display of unidentified 
peaks in the peak table.

If you want to... Then...

show a column 1. From the Hidden Columns list, select 
the column(s) you want to appear in the 
peak tables.

2. Click the <<Show button.

The selected columns appear in the 
Displayed Columns list.

hide a column 1. From the Displayed Columns list, 
select a column(s).

2. Click the Hide>> button.

The selected columns are deleted from 
the Displayed Columns list.

move a column 1. Click the column you want to move.

2. Hold the left mouse button down and 
drag the column name to the desired 
position in the list.

Use the... To...
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Using the Sequence Tables Page

Description The Sequence Tables page allows you to enter the default display 
settings for sequence windows.

Setting Sequence
Tables Page

Options

To set the Sequence Tables options:

1. With the SequencePro Preferences dialog box displayed, click 
the Sequence Tables tab to open the Sequence Tables page.
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2. Set the Sequence Tables options:

3. Click another tab or, if you are done, click OK in the 
SequencePro Preferences dialog box.

In this section... You can...

General Settings select the Full Name, 1-Letter, or 3-Letter 
amino acid designation from the AA 
Names pull-down menu.

click the check box to highlight the called 
value.

set the font by taking the following 
action:

1. Click the Font button to select the font 
for sequence tables, using the Font 
dialog box.

2. When you are finished, click OK.

Tables Displayed in 
Sequence Window

click the check boxes for the tables you 
want to display in the Sequence window.
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Using the Reports Page

Description The Reports page allows you to set report preferences, including 
what information is included in your report, and how information 
appears on the page.

Viewing the
Reports Page

To set the Reports options:

1. With the SequencePro Preferences dialog box, click the Reports 
tab to open the Reports page.

2. Set the reports options:

In this section... You can use...

Report Sections the check boxes to select the information 
you want to appear in your report.

Only those sections that are checked will 
appear.

Sample 
Information Page

the check boxes to choose customer and 
chemical information in the report.
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3. Click another tab, if you are done, or click OK in the 
SequencePro Preferences dialog box.

Chromatogram 
Page Options

to specify chromatogram, peak tables, or 
both in the report.

Show Cycles to specify a range of chromatogram 
cycles to be included in the report.

In this section... You can use...
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Setting Toolbar Options

Description Setting the Toolbar Options allows you direct access in the 
Chromatogram window to the following toolbars:

• Standard toolbar

• Zoom toolbar

• Windows toolbar

• Events toolbar

Setting Toolbar
Options

To set toolbar options:

1. Choose Toolbars from the View menu. 

The Toolbars dialog box opens.

2. Click the Standard check box to make the Standard toolbar 
open whenever the Chromatogram window is open.

For more information, see “Using the Standard Toolbar” on 
page 2-18.

3. Click the Zoom check box to make the Zoom toolbar open 
whenever the Chromatogram window is open.

For more information, see “Using the Zoom Toolbar” on 
page 2-19.

4. Click the Windows check box to make the Windows toolbar 
open whenever the Chromatogram window is open.

For more information, see “Using the Windows Toolbar” on 
page 2-20.
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5. Click the Events check box and the Events toolbar will appear 
whenever the Chromatogram window is open.

For more information, see “Using the Events Toolbar” on 
page 2-21.
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Using the Standard Toolbar

Standard Toolbar
Diagram

The figure below shows the Standard toolbar.

Using the
Standard Toolbar

Buttons

Click a button in the Standard toolbar to create new or to open 
existing Sample files, or perform standard computer functions.

The table below summarizes the Standard toolbar buttons.

1 2 3 4 5 6 7 8 9

Button Description Function

1 Open Sample Opens an existing Sample file.

2 Save Saves the file.

3 Print Prints the active window.

4 Cut Cuts the selection.

5 Copy Copies the selection.

6 Paste Pastes the selection.

7 Undo Undoes the last action.

8 Redo Redoes the last action.

9 Help Opens the Help file.
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Using the Zoom Toolbar

Zoom Toolbar
Diagram

The figure below shows the Zoom toolbar.

Using the Zoom
Toolbar Buttons

Click a button in the Zoom toolbar to enlarge or to reduce the 
selected area in the active window. 

The table below summarizes the functions of the Zoom toolbar 
buttons.

1 2 3 4

Button Description Function

1 Zoom In Magnifies the display.

2 Zoom Out Reduces the display.

3 View 100% Shows the display in normal size.

4 Page View Always displays the entire page.
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Using the Windows Toolbar

Description Click a button in the Windows toolbar to view various windows.

Windows Toolbar
Diagram

The figure below shows the Windows toolbar.

Using the
Windows Toolbar

Buttons

The table below summarizes the Windows toolbar buttons.

1 72 3 4 5 6

Button Description Function

1 Chromatogram 
Window

Displays the chromatogram window.

2 Sequence Window Displays the Sequence window.

3 Graph Window Displays the Graph window.

4 Report Window Displays the Report window.

5 Compare Window Displays one or more 
chromatograms.

6 Event Log Displays the Event Log.

7 Sample 
Information

Displays the Sample Information 
table.
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Using the Events Toolbar

Description Use the buttons on the Events toolbar to modify the integration 
parameters. All modifications made with the Events toolbar are local 
(i.e., they apply only to the currently active chromatogram).

Events Toolbar
Diagram

The figure below shows the Events toolbar.

Using the Events
Toolbar Buttons

See the table below for descriptions and functions of the Events 
toolbar buttons.

Note: For a detailed description of the integration parameters see 
“Using Events” on page A-17.

1 2 3 4 5 6 7 8 9 10 11 12 13

Events Toolbar Buttons

Button 
Set Description Function

1 +P, Peak detection on Enables peak detection (default).

–P, Peak detection off Disables peak detection.

2 S, Start or split peak Specifies the starting point of a split 
peak.

E, End of peak Specifies the end point of a split 
peak.

3 +M, Start manual 
integration

Adjusts a baseline manually and 
prevents normal baseline 
adjustment.

–M, Stop manual 
integration

Turns off manual baseline 
adjustment and allows normal 
baseline adjustment.
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4 +N, Negative peak 
detection on

Enables negative peak detection.

–N, Negative peak 
detection off

Disables negative peak detection 
(default).

5 +I, Inhibit end of peak Prevents finding the end of a peak.

–I, Allow end of peak Lets the software find the end of a 
peak (default).

6 +C, Force common 
baseline

Draws a common baseline for a 
series of peaks.

–C, Discontinue 
common baseline

Discontinues drawing a common 
baseline for a series of peaks.

7 +V, Force valley to 
valley baseline

Draws separate baselines for each 
peak in a series of peaks.

–V, Discontinue valley 
to valley baseline

Discontinues drawing separate 
baselines for each peak in a series 
of peaks.

8 +X, Exponential skim 
on 

Forces an exponential skim to start 
on a peak.

–X, Exponential skim off Prevents an exponential skim from 
starting on a peak, if the peak 
meets the criteria for exponential 
skimming.

9 +F, Force horizontal 
baseline forward

Forces a horizontal baseline 
forward from the timed event.

–F, Discontinue 
horizontal baseline 
forward

Discontinues the horizontal 
baseline.

10 T, Tangential skim on Forces a tangential skim to start on 
a peak.

Events Toolbar Buttons (continued)

Button 
Set Description Function
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11 BL, Force baseline to 
point

Forces the baseline to the start of a 
peak.

HR, Force horizontal 
baseline backward

Forces the baseline backward from 
the time of the event.

12 BF, Reset bunching 
factor

Resets the numerical value of the 
bunching factor.

NT, Reset noise 
threshold

Resets the numerical value of the 
noise threshold.

13 AT, Reset area 
threshold

Resets the numerical value of the 
area threshold.

Events Toolbar Buttons (continued)

Button 
Set Description Function
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3Viewing Sample Data 3

About This
Chapter

This chapter describes how to use the windows, commands, and other 
options of the SequencePro® Data Analysis Application v2.1 
software.

In This Chapter This chapter contains the following topics:

Using the Chromatogram Window . . . . . . . . . . . . . . . . . . . . . . . . .3-2

Using the Context Menus  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-9

Using Multiple Windows. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-10

Using the Compare Command  . . . . . . . . . . . . . . . . . . . . . . . . . . .3-13

Using the Axes Settings Options. . . . . . . . . . . . . . . . . . . . . . . . . .3-17

Viewing Sample Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-21

Using the Sample Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-23

Using the Laboratory Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-24

Using the Customer Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-25

Using the Comments Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-26

Using the Chemicals Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-27

Using the Sequencing Method Page . . . . . . . . . . . . . . . . . . . . . . .3-28

Viewing the Chromatogram Log. . . . . . . . . . . . . . . . . . . . . . . . . .3-29
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Using the Chromatogram Window

Description The chromatogram window displays the chromatogram and/or peak 
table for each chromatographic cycle in a sample file. You can 
modify and customize the appearance of the chromatogram window 
to suit your needs.

The chromatogram window is displayed by default whenever you 
open a sample file.

Chromatogram
Window Example

The following is an example of the chromatogram window. A table 
follows to explain the numbered areas.

1

2

3

4
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Chromatogram
Window

Description

The following table lists the numbers from the previous diagram:

Reanalyze Button The Reanalyze button is active if Automatic Analysis is off. If you 
make a change when the Automatic Analysis is off, for example, 
adding an event, then click reanalyze to update the chromatogram.

Chromatogram
and Peak Table

Viewing Options

The following table lists the chromatogram window viewing options:

No. Description For more information, see...

1 View next or previous 
cycle

“Cycle Viewing Options” on page 3-4.

2 View any cycle

3 View chromatogram 
and or peak table

“Chromatogram and Peak Table 
Viewing Options” on page 3-3.

4 Reanalyze button “Reanalyze Button” on page 3-3.

5 View split windows “Viewing the Chromatogram and the 
Peak Table” on page 3-5.

If you want to view the... Then click...

chromatogram only show chromatogram icon button.

peak table only show peak table icon button.

chromatogram and the peak table 
together

show chromatogram and the peak 
table icon button.
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Viewing Multiple
Chromatogram

Windows for
Multiple Sample

Files

To view multiple chromatogram windows simultaneously:

1. Open each one using the File Open command.

2. Click on the window you wish to view to bring it to the front. 

Other windows will hide behind the active chromatogram.

Viewing Extra
Chromatogram

Windows for the
Same File

Viewing extra chromatogram windows for the same file can be useful 
for comparing the cycles in the sample.

To view extra chromatogram windows for the same file:

1. Open the chromatogram window.

2. Select New Chromatogram Window from the Window menu.

3. Select Tile Horizontal from the Window menu.

4. Select Synchronize Cycles from the Chromatogram menu.

5. Click either the right or left arrow to cycle through the 
sequences.

Cycle Viewing
Options

You have the following options:

If you want to view... Then...

the next or the previous cycle in 
the sample

click the right- or left-pointing 
arrows.

a specific chromatogram or cycle, 
or any residue chromatogram

select it from the pull-down menu.

Pull-down menu
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Viewing the
Chromatogram

and the Peak
Table

Split-Window Option

The split-window option allows you to view both the chromatogram 
and the peak table. All chromatogram windows have the split-
window option.

To split the window, move the cursor to the:

• Bottom of the chromatogram, or 

• Top of the table, if you are in the Peak table view

You can do the following when the cursor changes from an arrow to 
the window splitter icon:

If you are in... Then... Result

Chromatogram 
view

hold the mouse 
button down and 
drag the cursor up

The chromatogram 
pane is 
compressed as the 
table pane enlarges 
(see “Split-Window 
Example” below). 

The peak table 
shows information 
about the peaks in 
the cycle.

Peak table view hold the mouse 
button down and 
drag the cursor 
down
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Split-Window Example
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Using the Peak
Table

To use the peak table, you can take the following action:

Zooming Options Use the Zoom toolbar as follows:

Note: The Axes Settings dialog box also allows you to zoom in or 
out. For more information see “Setting Scale Properties” on 
page 3-18.

If you want to... Then...

go to a specific peak in the peak 
table

double-click the arrow icon that 
appears when you place the 
cursor on a peak.

go to a specific peak in the 
chromatogram window

Click the row in the table.

The selected peak is highlighted, 
as a box outlines the peak in the 
chromatogram window.

If you want to... Then...

zoom in of the chromatogram 
window.

click

zoom out of the chromatogram 
window.

click

restore the full chromatogram 
window view.

click

view a specific region of the 
chromatogram

Hold down the mouse button and 
drag over the area of interest.
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Home View To set the view of the chromatogram so that it opens as the same 
size for every cycle in the sample, take the following action:

Changing
Settings

You can take the following action:

If you want to... Then...

preserve a chromatogram view select Save Home View from the 
chromatogram menu.

restore the view you can either:

• Click the  or
• From the View menu, select 

100%

If you want to change settings... Then select...

in the current file Settings from the chromatogram 
menu.

for all new files (Default) Preferences from the View menu.
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Using the Context Menus

Description A context menu is available in each window. It displays a list of 
commands that can be used on the selected item.

Viewing Context
Menus

To view a context menu right-click in the window. The context menu 
opens at the cursor. 

Two examples of context menus are shown below.

Context menu, as it appears 
in the chromatogram 

Context menu, as it appears 
in the graph window
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Using Multiple Windows

Description When more than one window is open on the screen, you can use the 
Window pull-down menu to organize them in one of the following 
arrangements:

• Cascade

• Tile Horizontal

• Tile Vertical

Cascade This option displays open windows in a cascade pattern, as follows:
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Tile Horizontal This option displays open windows in a horizontal tile pattern, as 
follows:
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Tile Vertical This option tiles open windows vertically, as follows:
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Using the Compare Command

Description Use the Compare command from the View menu to:

• Analyze up to six residue cycles

• Analyze one or more residue cycle(s) and the standard cycle

and determine the similarities and the differences between them.

Procedure To compare several cycles:

1. Select Compare from the View menu to open the Select Cycles 
dialog box.

2. Select the cycles you wish to compare. Residue cycles 1 through 
5 have been selected below.
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3. Click OK to open the Chromatogram Compare window. 

Displaying
Overlaid Cycles

To display overlaid cycles:

1. Click the light bulb button on the Chromatogram Compare 
toolbar to use the lightbox option. Selected cycle traces are 
overlaid in the chromatogram window.
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2. Improve the alignment.

a. Move the cursor over the chromatogram. The cross hairs 
will change to a hand. 

b. Click and hold the left mouse button to select the 
chromatogram and drag to the desired location.

Displaying
Multiple Panes

To display multiple panes click on the chromatograms button on the 
Chromatogram Compare toolbar.
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Changing the
Chromatogram

Selection

When the Chromatogram Compare window opens, the Compare 
drop-down menu is available. The Compare drop-down menu takes 
the place of the Chromatogram drop-down menu in the Compare 
mode.

To change the chromatogram selection, select Select Cycles. You can 
also switch between lightbox and multiple pane display modes and 
activate the compare to standard mode using this menu.
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Using the Axes Settings Options

Description The Axes Settings options allow you to set or edit the horizontal and 
vertical axes in the chromatogram window.

Setting Axes
Properties

To set the axes properties:

1. From the Chromatogram menu, select Axes Settings to open the 
Axes Settings dialog box.

2. Enter the desired information under the Scale and Tick Marks 
tabs.

Note: You can view or edit these pages in any order.

If... Then...

you check both Auto and 
Optimize in the mV Axis Scale 
section

the chromatogram will scale so 
that the vertical axis shows the 
tallest amino acid peak in the 
cycle.
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Setting Scale
Properties

The Scale page allows you to set the horizontal and vertical scales in 
the chromatogram window.

To set the scale properties of the chromatogram:

1. Open the Axes Settings dialog box to view the Scale page.

2. You can select the following from the Time Axis Scale 
(horizontal) section:

Select... To set the...

Auto horizontal axis to 30 sec before start of integration 
and 30 sec after integration stops, so that all amino 
acids are visible.

Fixed minimum and maximum time settings in minutes.
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3. You can select the following from the mV Axis Scale (vertical):

4. Click the Tick Marks tab or, if you are done, click OK.

For information on setting the tick mark properties, see “Setting 
Tick Mark Properties” on page 3-19.

Setting Tick Mark
Properties

The Tick Marks page allows you to set the horizontal and vertical tick 
marks in the chromatogram window.

To set tick mark properties:

1. Click the Tick Marks tab in the Axes Settings dialog box to 
open the Tick Marks page.

2. Select the following from the Time Axis Tick Marks 
(horizontal) section.

Select... To set the...

Auto maximum mV scale to match the height of the 
tallest peak in the chromatogram. 

Sets the minimum mV scale just below the lowest 
scale in the chromatogram.

Fixed minimum and maximum settings in mV.

Select... To...

Auto optimally set the major and minor tick marks. 

• Major tick marks have time labels.
• Minor tick marks are small ticks.
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3. You can select the following from the mV Axis Tick Marks 
(vertical) section:

4. Click the Scale tab or, if you are done, click OK.

For information on setting the scale properties, see the 
procedure on page 3-18.

Fixed set the major and minor tick mark settings.

Select... To...

Auto optimally set the major and minor tick marks. 

• Major tick marks have mV labels
• Minor tick marks are small ticks.

Fixed set the major and minor tick mark settings.

Select... To...
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Viewing Sample Information

Description Use the Sample Information dialog box to view or modify 
information about a sample.

Procedure To view sample information:

1. From the View menu, select Sample Information.

The Sample Information dialog box appears.
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2. Click each of the following tabs in the Sample Information 
dialog box and enter the required information on each page. 

Click a new tab after you complete each page.

The following table lists where to find more information about 
each page. 

Note: These pages may be viewed or edited in any order. 

3. Click OK when you have completed viewing or editing 
information in all of the pages.

For this topic... See Page...

Using the Sample Page 3-23

Using the Laboratory Page 3-24

Using the Customer Page 3-25

Using the Comments Page 3-26

Using the Chemicals Page 3-27

Using the Sequencing Method Page 3-28
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Using the Sample Page

Description Use the Sample page to view or edit information about the sample, as 
well as view information about the sequencer. The information 
entered in the Preferences dialog box is the default information.

Viewing Sample
Information

To view sample information:

1. In the Sample Information dialog box, click the Sample tab to 
open the Sample page.

2. Enter, view, or edit the sample identification, parameters, or 
sequencer method information.

3. Click another tab or, if you are done, click OK.
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Using the Laboratory Page

Description Use the Laboratory page to view or enter information about your 
laboratory and the names of the operators. The information entered in 
the Preferences dialog box is the default information.

Viewing
Laboratory
Information

To view the laboratory information:

1. In the Sample Information dialog box, click the Laboratory tab 
to open the Laboratory page.

2. Enter, view, or edit laboratory and operator information.

3. Click the Use Default button to use the default name and 
address.

4. Click the Save as Default button to automatically update 
preferences, thus creating a new default identification.

5. Either:

• Select the name of an operator from the Operator Name 
pull-down menu, or

• Enter the operator name if it is not on the list

Operator names are entered using the Preferences menu 
(see “Using the Laboratory Page” on page 2-4).

6. Click another tab or, if you are done, click OK.
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Using the Customer Page

Description Use the Customer page to enter customer profiles and billing 
information. The information entered in the Preferences dialog box is 
the default information.

Viewing the
Customer Profiles

To view customer profiles and billing information:

1. In the Sample Information dialog box, click the Customer tab to 
open the Customer page.

2. Enter, view, or edit the customer profile and the billing 
information.

3. Click another tab or, if you are done, click OK.
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Using the Comments Page

Description Use the Comments page to view or write comments about your 
sample.

Writing
Comments

To write comments:

1. In the Sample Information dialog box, click the Comments tab 
to open the Comments page.

2. Enter your comments.

3. Click another tab or, if you are done, click OK.
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Using the Chemicals Page

Description Click the Chemicals tab to list all the information from the bottle 
change view of the protein sequencer pertaining to the currently 
opened SequencePro data file. 

The list includes the name of the reagent, solvent or other 
consumable used in the analysis of the sample, the lot number, and 
the date of change.
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Using the Sequencing Method Page

Description Click the Sequencing Method tab to list all the method information 
from the protein sequencer pertaining to the opened SequencePro 
software data file. 

The list includes step by step listings of the method, cartridge and 
flask cycles and gradient.
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Viewing the Chromatogram Log

Description The chromatogram log contains all the PROCISE software Event Log 
entries pertaining to the currently opened Sequence Pro software data 
file.

From the View menu, select Chromatogram Log to open the 
chromatogram Log window.
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4Analyzing Data Files 4

About This
Chapter

Analysis of sequencing data acquired from protein sequencers 
includes calibration of standard peaks, integration of residual peaks, 
and sequence calling. Using the SequencePro® Data Analysis 
Application v2.1 software, you can view the data after each of these 
steps and, if necessary, correct any data analysis problems.

In This Chapter This chapter contains the following topics:

Data Analysis Flow Diagram  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-2

Using Methods  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-3

Creating a New Method Template. . . . . . . . . . . . . . . . . . . . . . . . . .4-5

Using the Method Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-9

Editing a Method Template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-10

Selecting a Current Method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-11

Using Automatic Analysis. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-12

Editing the Current Method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-13

Calibrating a Standard Cycle. . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-14

Using the Calibration Table Page  . . . . . . . . . . . . . . . . . . . . . . . . .4-15

Integrating Residue Cycles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-17

Using the Global Events Page . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-18

Using the Integration Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-20

Using the Sequence Calling Page . . . . . . . . . . . . . . . . . . . . . . . . .4-23

Editing the Data Dictionary . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-25

Calling the Sequence. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-28
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Data Analysis Flow Diagram

Flow Diagram This flow diagram illustrates the process of analyzing a data file.

Start Analysis
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 Calibrate a 
Standard Cycle

Calibration 
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Use the 
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Correct 
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Problems

Analysis 
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Sequence
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Call the 
Sequence

End Analysis
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NO
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Correct 
Analysis 
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Correct 
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Using Methods

Definition Methods are complete sets of data analysis parameters that can be 
shared by multiple SequencePro software data files.

Example of How
Methods Are

Used

The following figure illustrates how methods are used.

Where Methods
Are Stored

Methods are stored by default in the Methods folder specified in the 
File Locations page of the Preferences dialog box. Method templates 
can also be stored in any folder on the disk or on the network.

What Methods
Contain

The SequencePro software Methods contain the following 
information:

METHOD
TEMPLATE

DATA FILE 2

METHOD

Calib Table
Global Events

Int Params
Seq Params

DATA FILE 1

METHOD

Calib Table
Global Events

Int Params
Seq Params

METHOD

Calib Table
Global Events

Int Params
Seq Params

STEP 1: 
Copy of method created in data file.

STEP 2: 
Method saved as template.

STEP 3: 
Template copied to new data file.

Methods contain... For information, see...

Calibration table “Using the Calibration Table Page” on 
page 4-15.

Global events “Using the Global Events Page” on 
page 4-18.
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The SequencePro software attaches the Methods you choose to your 
data files.

Creating,
Selecting, and

Editing Methods

The SequencePro software allows you to create, select, and edit 
Methods.

Saving and
Copying from and

to a Method

Use the Method menu to:

• Save a current method as a template

• Copy a Calibration Table from a Method or Sample file (see 
“Copying a Calibration Table” on page 4-16)

• Copy standard peaks to a method to create a calibration table

Integration parameters “Using the Integration Page” on page 4-20.

Sequence calling options “Using the Sequence Calling Page” on 
page 4-23.

Methods contain... For information, see...

If you want to... Then see...

Create a new Method template “Creating a New Method 
Template” on page 4-5.

Select a previously created 
Method template and include it in 
the data file you are currently using

“Selecting a Current Method” on 
page 4-11.

Open and edit a previous created 
Method and include it in your 
current data file

“Editing the Current Method” on 
page 4-13.

Edit a Method template “Using the Method Editor” on 
page 4-9.
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Creating a New Method Template

Creating a
Method Template

To create a new Method template:

1. From the Method menu, select Create Template. 

The following dialog box appears.

The New Method Lab Assistant takes you through the following 
steps.

During each step you can take any of the following actions:

2. From the Sequencer Model pull-down menu, select a sequencer 
model and click Next. The following dialog box appears.

Note: If you do not want to import a calibration table at this 
time, click Next only. You can specify the calibration table later 
using the Method properties dialog.

Click Description

Help For more information.

Cancel Discard the new method.

Back Go to the previous New Method Lab Assistant 
step.

Next Go to the Next Method Lab Assistant step.
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a. Click the button to select where you want to copy a 
calibration table from and click OK. 

b. When the directory dialog box appears, navigate to the files 
from which you want to copy the calibration table.

If you... Then click...

want to import a calibration 
table

Import Calibration Table to 
import a calibration table from 
an existing method or data file.

The following dialog box 
appears (see below).

do not want to import a 
calibration table

Next.

You can specify the calibration 
table later using the Method 
properties dialog.
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3. Set the Integration Start and Stop times.

Enter the times (in minutes) you want to start and stop 
integration in each cycle.

Note: You can modify these values later using the Method 
properties dialog.

4.  Set the Default Integration Parameters.

Enter the default values for the bunching factor, noise threshold, 
and area threshold.
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5.  Set the Maximum Number of Peaks.

Enter a value for the maximum number of peaks you want to 
analyze. 

Note: The maximum number of peaks allowed per cycle is 128.

The Task Complete: Save Method File dialog box opens. A new 
Method template has been created.

6. Click the Finish button to save the new method as a Method 
template in the Method folder.

The new Method template is opened in the Method Editor 
window.
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Using the Method Editor

Description You can use the Method Editor to edit the current Method within a 
sample file or to edit an existing Method template.

The Method Editor allows you to edit parameters for the following:

Opening the
Method Editor

From the Method menu, select Edit Current or Edit Template.

You can edit these 
parameters... For information, see...

Calibration table “Using the Calibration Table Page” on page 4-15.

Global events “Using the Global Events Page” on page 4-18.

Integration “Using the Integration Page” on page 4-20.

Sequence calling “Using the Sequence Calling Page” on 
page 4-23.
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Editing a Method Template

Description Use to open and edit a previously created Method template. The 
edited Method template will be used with all data files attached to it.

Procedure To edit a previously created Method template:

1. From the Method menu, select Edit Template. 

The Method Editor dialog box appears.
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2. In the Method Editor dialog box, click each of the following 
tabs, and type in your changes. 

The following table lists where to find more information about 
each tab:

Click a new tab after you complete each page.

Note: These pages may be completed in any order.

3. Click OK in the Method Editor dialog box when you have 
completed entering your changes.

Selecting a Current Method

Description Allows you to copy the contents of a Method template into the 
current data file.

Procedure To select a Method template to include in your current data file:

1. From the Method menu, select Select Current.

The standard Open dialog box displays.

2. Locate and select a Method template.

The Method is now attached to the data file.

For this topic... See Page

Using the Calibration Table Page 4-15

Using the Global Events Page 4-18

Using the Integration Page 4-20

Using the Sequence Calling Page 4-23
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Using Automatic Analysis

Description Automatic Analysis automatically keeps a data file analyzed 
whenever you:

• Add integration events

• Change analysis settings

• Modify peak names

Reanalyzing If Automatic Analysis is off, click the Reanalyze button in the 
chromatogram window after making any changes (for example, 
adding an event). The updated chromatogram will be displayed.

Reanalyze button
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Editing the Current Method

Description Allows you to select and edit the copy of the Method template 
included in the data file. The edited Method will be used only with 
the current data file.

Procedure To edit the Method template included in your data file:

1. From the Edit menu, select Edit Current. 

The Method Editor dialog box opens.



DRAFT
September 1, 2005 4:04 pm, Ch_4_Analyzing Data.fm

Chapter 4 Analyzing Data Files

4-14 SequencePro®  Data Analysis Application v2.1 User Guide 

2. Click each of the following tabs in the Method Editor dialog box 
and type in your changes on each page.

The following table lists where to find more information about 
each tab: 

Click a new tab after you complete each page.

Note: These pages may be completed in any order.

3. Click OK in the Method Editor dialog box when you have 
finished entering your changes.

Calibrating a Standard Cycle

Description When the SequencePro software calibrates the standard cycles:

• All standard peaks are assigned the correct amino acid labels 
based on the contents of the Calibration table.

• All peaks are assigned the correct quantity (pmol) of standard for 
the height and area recorded.

Procedure To calibrate the standard cycle, select Calibrate from the Analysis 
menu. If Automatic Analysis is on, the program automatically 
calibrates the standard cycle.

For this topic... See Page

Using the Calibration Table Page 4-15

Using the Global Events Page 4-18

Using the Integration Page 4-20

Using the Sequence Calling Page 4-23



DRAFT
September 1, 2005 4:04 pm, Ch_4_Analyzing Data.fm

Using the Calibration Table Page

SequencePro®  Data Analysis Application v2.1 User Guide 4-15

Using the Calibration Table Page

Description Use the Calibration Table page to edit the calibration parameters.

Displaying the
Calibration Table

Page

To display the Calibration Table page, from the Method Editor dialog 
box, click the Calibration Table tab to open the Calibration Table 
page.

Adding a
Component

To add a component:

1. From the Calibration Table page, click the Add Component 
button.

The Add Calibration Component dialog box opens.

2. Select an amino acid from the Component pop-up menu.



DRAFT
September 1, 2005 4:04 pm, Ch_4_Analyzing Data.fm

Chapter 4 Analyzing Data Files

4-16 SequencePro®  Data Analysis Application v2.1 User Guide 

3. Enter the retention time in the Ret Time text box, and click OK.

4. If the component you want to add is not listed in the pop-up 
menu:

a. Click the Create New Component button. The Data 
Dictionary dialog box opens.

b. Add the component to the Data Dictionary. See “Editing the 
Data Dictionary” on page 4-25.

c. Return to step a to select the new component.

5. Click OK.

6. Click another tab or, if you are done, click OK in the Method 
Editor dialog box.

Copying from
Standard

Use the Copy from Standard button to replace all the components in 
the list with the components from the Standard Cycle.

Copying a
Calibration Table

Using the Method menu, you can also copy a Calibration Table from 
a Method or Sample file.

To copy a Calibration Table:

1. Open the Method Editor dialog box.

2. Click the Copy from File button in the Calibration Table page. 

The Copy Calibration Table dialog box opens.

3. Select the button next to the item that you want to do and click 
OK.
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Deleting
Components

To delete one component, select a component from the list and click 
the Delete Component button.

To delete all components, click Delete All.

Note: Click Copy from Standard to add the components from the 
Standard Calibration Table.

Integrating Residue Cycles

Description When the SequencePro software integrates residue cycles, it 
compares the heights or areas of the residue peaks for each cycle to 
the heights or areas of the standard peaks. The amount of each amino 
acid in the residue cycle is then calculated.

Procedure Select Integrate from the Analysis menu to have the SequencePro 
software integrate the residue cycles. If Automatic Analysis is on, 
residue cycles are automatically integrated.
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Using the Global Events Page

Description Use the Global Events page to simultaneously edit events that apply 
to all cycles.

Editing Global
Events

To edit global events:

1. From the Method Editor dialog box, click the Global Events tab 
to open the Global Events page.

2. You can take the following action:

If you want to... Then...

delete an event 1. Select an event by clicking in the row 
header.

2. Click the Delete Event button.
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3. Click another tab or, if you are done, click OK in the Method 
Editor dialog box.

add an event 1. Click the Add Event button.

2. The Integration Event Properties dialog 
box appears. 

3. Select an event from the Event drop-
down menu.

4. Enter the time and value of the event, 
then click OK.
This event is now changed in all cycles.

If you want to... Then...
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Using the Integration Page

Description Use the Integration page to edit parameters for peak detection, peak 
separation, and exponential skim.

Editing
Integration

Parameters

To edit integration parameters:

1. From the Method Editor dialog box, click the Integration tab to 
open the Integration page.
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2. In the Edit Peak Separation Criteria section, you can take the 
following actions (refer to “Understanding Peak Separation and 
Exponential Skim Parameters” on page A-13):

Field Description

Width Ratio The Width Ratio is the ratio of the distance 
between the end of the first peak and the 
start of the second peak to the width of the 
second peak at its base (w). See the figure 
below. 

If this ratio is greater than the set value, the 
peaks are considered to be separated. 
Otherwise, they are marked as overlapped.

Valley to Peak The Valley-to-Peak Ratio is the ratio of the 
height of the valley between peaks (v) to the 
height of the smaller peak (p). 

If this ratio is less than or equal to the set 
value, the peaks are considered to be 
separated. Otherwise they are marked as 
overlapped.
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3. In the Edit Exponential Skim Criteria section, you can take 
the following action (refer to “Understanding Peak Separation 
and Exponential Skim Parameters” on page A-13):

4. Click another tab or, if you are done, click OK in the Method 
Editor dialog box.

Field Description

Peak Height 
Ratio

The Peak Height Ratio is the ratio of the 
baseline-corrected height of the parent peak 
to the baseline corrected height of the child 
peak. 

This ratio must be greater than the set value 
for the child peak to be skimmed. 

To disable exponential skimming throughout a 
run, you can set this parameter to its 
maximum value (1.0e+06).

Adjusted 
Height Ratio

The Adjusted Height Ratio is the ratio of the 
height of the parent above its start point to the 
height of the child above the same point. 

This ratio must be greater than the set value 
for the child peak to be skimmed.

Valley Height 
Ratio

The Valley Height Ratio is the ratio of the 
baseline corrected height of the child peak 
(Hd) to the height of the valley between the 
parent and child peaks above the baseline 
(Hv). 

This ratio must be less than the set value for 
the child peak to be skimmed.
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Using the Sequence Calling Page

Description Use the Sequence Calling page to adjust the internal parameters used 
by the SequencePro software sequence caller. 

Note: These settings should be used with caution.

Editing Sequence
Calling

Parameters

To edit sequence calling parameters:

1. From the Method Editor dialog box, click the Sequence Calling 
tab to open the Sequence Calling page.

You can take the following action:

If you want to use... Then click...

the default settings the Use Default Settings 
button.

peak height to determine the 
amount of each amino acid in 
the residue cycle

in the Pmol Values section, 
click the Use Heights button.

peak area to determine the 
amount of each amino acid in 
the residue cycle

in the Pmol Values section, 
click the Use Areas button.
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2. In the Scoring Weights section, you can take the following 
action:

3. Click another tab or, if you are done, click OK in the Method 
Editor dialog box.

Value Definition

Raw Slope 1 Score applied to the amino acid with the 
largest raw slope increase.

Raw Slope 2 Score applied to the amino acid with the 
second largest raw slope increase.

Bkgd Slope 1 Score applied to the amino acid with the 
largest background slope increase.

Bkgd Slope 2 Score applied to the amino acid with the 
second largest background slope increase.

Max Slope Score applied to the amino acid with the 
maximum slope.

Rule Book Score applied to the best match for the rule 
book criteria.

Dev Deviation multiplier for calculating background 
and lag values.

Raw Yield Score applied to the amino acid with the 
largest raw yield.

Bkgd Yield Score applied to the amino acid with the 
largest background yield value.

Lag Yield Score applied to the amino acid with the 
largest lag yield value.

Rep Yield Score applied to the amino acid with the 
largest repetitive yield value.

Low Score applied to the amino acid with the 
lowest repetitive yield value.

BkgdSens Background sensitivity value used during 
sequence calling.
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Editing the Data Dictionary 

Contents The Data Dictionary contains both component and sequence 
information. This section describes how to edit the Data Dictionary 
by adding or deleting components and sequences.

About the
Components

The Data Dictionary contains a list of components to be identified 
during the analysis process. You can add or delete components to the 
Data Dictionary or modify their parameters.

Adding
Components to

the Data
Dictionary

To add a component to the Data Dictionary:

1. From the View menu, select Data Dictionary. 

The Data Dictionary dialog box appears and the Components 
page is displayed.

2. Click the Add button to display the following dialog box.

3. Enter the long name for the component and click OK.
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4. Enter the parameters of the new component in the appropriate 
fields:

5. Click the appropriate check boxes in the Default Attributes 
section. By selecting these check boxes, these become the 
default settings for each component.

6. Click Add to add the new component to the Data Dictionary.

The component becomes the default in the method template and 
in the data file.

Deleting a
Component from

the Data
Dictionary

To delete a component from the Data Dictionary:

1. From the View menu, select Data Dictionary. 

The Data Dictionary dialog box appears and the Components 
page is displayed.

2. Select the component you want to delete from the Component 
Name scroll box.

New Component Parameter... For example...

Long Name Alanine

3-Letter ALA

1-Letter A

Select... To...

Amino Acid designate that peak as an amino acid.

Label Peak make the label appear in the 
chromatogram window.

Reference designate the peak as a reference peak.

Internal 
Standard

designate the peak as an internal 
standard.
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3. Click the Delete button.

The component is deleted from the Data Dictionary.

Note: Standard Amino Acids cannot be deleted from the Data 
Dictionary, nor can the Amino Acid check box be changed.

Adding
Sequences to the

Data Dictionary

The Data Dictionary also contains sequence information that can be 
edited.

To add sequences to the Data Dictionary:

1. From the View menu, select Data Dictionary and click the 
Sequences tab to display the Sequences page.

2. Click the Add button to display the following dialog box.

3. Enter the protein/peptide name and click OK.

The cursor moves to the Amino Acid Sequence window.

4. Enter the amino acid sequence.

5. Click OK to add the new sequence to the Data Dictionary.
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Deleting a
Sequence from

the Data
Dictionary

To delete a sequence from the Data Dictionary:

1. Select the sequence you want to delete from the Protein/Peptide 
Name scroll box.

2. Click the Delete button.

The sequence is deleted from the Data Dictionary.

Calling the Sequence

Description When the SequencePro software calls the sequence, it compares the 
relative heights or areas of residues in each cycle with the relative 
heights or areas of residues in the previous cycle. The residue with 
the largest change is called.

Procedure To call the sequence, select Call Sequence from the Analysis menu. 
The SequencePro software automatically calls the protein sequence.
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5
Correcting Calibration 
Problems 5

About This
Chapter

This chapter describes how to correct analysis and calibration 
problems, specify reference peaks, edit and delete events, and modify 
integration parameters.

In This Chapter This chapter contains the following topics:

Correcting Analysis Problems. . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-2

Adjusting Retention Time Windows . . . . . . . . . . . . . . . . . . . . . . . .5-3

Specifying Reference Peaks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-5

Editing and Deleting Global Events . . . . . . . . . . . . . . . . . . . . . . . .5-7

Editing Local Events . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-9

Modifying Integration Parameters  . . . . . . . . . . . . . . . . . . . . . . . .5-12
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Correcting Analysis Problems

Correcting
Process

If you find problems with the calibration of any of the standard 
cycles, you will need to make adjustments. This process involves 
visually inspecting the standard peaks, and then modifying the 
integration and retention times, as necessary.

Flow Diagram The following flow diagram illustrates the process of correcting 
calibration problems.
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Adjusting Retention Time Windows

Description Retention time windows define the time span in which a peak must 
occur in order to be identified as a given component. You can 
compensate for any shifting of the retention times of the peaks by 
widening the retention time window.

Procedure Use the following procedure to open the Calibration Table tab and 
adjust the retention time window.

To adjust the retention time window:

1. From the Method menu, select Edit Current.

The Method Editor dialog box appears and the Calibration Table 
tab is displayed.

2. Select the appropriate amino acid from the scroll box on the left.

3. If necessary, enter the new retention time in the Ret Time field, 
as shown in the example above.
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4. Enter the new width of the retention time window:

5. Click OK.

Viewing
Retention Times

To view the retention times on the chromatogram:

1. From the chromatogram window, select Settings.

2. Click the Chromatograms tab in the Chromatogram Settings 
dialog box that appears.

3. Select Off or On from the Ret. Time pop-up menu to specify if 
the retention time is to appear on the chromatogram.

4. Select the check box labeled RT Windows if you want the 
retention time window to appear on the chromatogram.

5. Click OK.

For a... Enter...

constant window width minutes in the Abs Window 
field.

variable window width a percent of the retention 
time in the Rel Window.
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Specifying Reference Peaks

The Problem Retention times for peaks can vary widely from run to run. Creating 
an excessively wide retention time window to find these peaks may 
cause windows to overlap. This complicates the peak identification 
process. and makes it more difficult to predict the peak 
identifications that the SequencePro® software will make.

What Is a
Reference Peak?

A reference peak, like other single-peak components, has an expected 
retention time and a search window. However, it is usually readily 
identifiable because it is well separated from other peaks, or because 
it is the largest peak in that region of the chromatogram.

Why Use
Reference

Peaks?

You can use reference peaks to compensate for shifts in peak 
retention times. Since all peaks shift by the same amount as the 
reference peak, you want to choose a reference peak that appears in 
every cycle, including the standard cycle and all residue cycles. 

Selecting a
Reference Peak

Note: When selecting a reference peak, always choose a component 
that is present in every cycle and shifts in the same general direction 
and time shift as the other peaks in the cycle.

To select a reference peak:

1. Click the Calibration Table tab in the Method Editor dialog 
box.

2. Click on the component you want to use as a reference peak, for 
example, dptu, in the scroll box on the left side (see the 
following figure).
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3. Click the Ref Peak check box. 

An ‘X’ appears in the check box and the selected component is 
added to the list of reference peaks.

4. Click OK.

Assigning a
Reference Peak

To assign the reference peak to an amino acid:

1. Click on an amino acid in the scroll box on the left side.

2. Select dptu (or another reference) from the Reference pop-up 
menu.

3. Repeat step 1 and step 2 to assign the reference peak to 
additional amino acids.

4. Click OK.
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Editing and Deleting Global Events

Description When you modify global events, you change the integration events 
for all cycles in the sample.

Editing Global
Events

To edit global events:

1. Choose a method to edit:

a. From the Method menu, select Edit Current. The Method 
Editor dialog box displays. 

b. Click the Global Events tab.

2. Add a global event: 

• Click the Add Event button, then select an event from the 
Event pop-up menu by clicking the row header, or 

• Shift-click and drag an event from the Event toolbar onto the 
chromatogram.

The selected event appears in the Event list as shown above.

Row header
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Deleting Global
Events

To delete a global event:

Global Event
Example

The following is an example of a global event.

If you want to delete... Then...

a global event 1. Select an event from the Event 
list by clicking on its row 
header.

2. Click the Delete Event button.

all global events Click the Delete All button.

These are global events. The short vertical line indicates where the event occurs.
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Editing Local Events

Description When you edit or add local events to a cycle, you change the 
integration results of only the active cycle. All other cycles remain 
unchanged.

Adding a Local
Event

Note: For a detailed description of the Events toolbar button 
functions see Appendix A, “Peak Detection and Integration,” on 
page A-3.

To add or modify local events:

1. In the Events toolbar, click the appropriate icon.

The cursor icon changes from an arrow to a one- or two-letter 
symbol with a short line.

2. Move the cursor to the appropriate place on the chromatogram, 
and then left-click to add the event.

Changes to the chromatogram analysis parameters appear.

Note: Shift-click to add a global event to every cycle.

For a description of the:

• Buttons on the Events toolbar, see “Using the Events 
Toolbar” on page 2-21.

• Events toolbar, see Appendix A, “Peak Detection and 
Integration.”

If automatic analysis is... Then the...

enabled sample is automatically 
reanalyzed.

not enabled reanalyze button is activated, 
so you can choose when to 
perform analysis.
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Local Event
Example

The following is an example of a local event.

These are local events. The circles indicate where the events occur.
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Editing a Local
Event

To edit a local event:

1. Click in the circle associated with the event.

The circle turns black.

2. From the Analysis menu, select Edit Event.

The Integration Event Properties dialog box opens.

3. From the Event pop-up menu, select a different event.

4. Change the time.

5. Click OK.

Deleting a Local
Event

To delete a local event:

1. Click in the circle associated with the event. 

The circle turns black.

2. From the Analysis menu, select Delete Event.

3. Click OK.

Adding a Local
Event to the

Method

To add a local event to a method:

1. Click in the circle associated with the event. 

The circle turns black.

2. From the Analysis menu, select Add Event.

The circle changes to a short line.

3. Click OK.
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Modifying Integration Parameters

Description When you modify integration parameters, you change the way all 
cycles in the sample are integrated.

Procedure To modify integration parameters:

1. Choose a method to edit:

a. From the Method menu, select Edit Current. The Method 
Editor dialog box appears.

b. Click the Integration tab.

2. In the Peak Detection Parameters section, click on an integration 
parameter.

A description of the parameter appears in the text box below 
(see also “Using the Integration Page” on page 4-20 for an 
overview of all the integration parameters).

3. Modify the parameter and then click OK.

All cycles in the sample will be integrated with this 
modification.

Text box
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6Viewing Sequence Data 6

About This
Chapter

This chapter describes the flow of the Sequence Calling process, and 
the tables that are used to display the results.

In This Chapter This chapter contains the following topics:

Sequence Calling Flow Diagram. . . . . . . . . . . . . . . . . . . . . . . . . . .6-2

Viewing Tables in the Sequence Window . . . . . . . . . . . . . . . . . . . .6-3

Using the Sequence Call Table . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-4

Using the User Call Table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-5

Using the Raw Picomole Table . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-6

Using the Background Corrected Table  . . . . . . . . . . . . . . . . . . . . .6-7

Using the Lag Corrected Table . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-8

Using the Scores Table  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-9

Viewing Graph Windows  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-10

Using the Amino Acid Yield Graph . . . . . . . . . . . . . . . . . . . . . . .6-15

Using the Cycle Yield Graph  . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-16

Using the Repetitive Yield Graph . . . . . . . . . . . . . . . . . . . . . . . . .6-17

Graphing User Sequence. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-18
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Sequence Calling Flow Diagram

Description The SequencePro® Data Analysis Application v2.1 software 
identifies the called amino acid sequence by collating all of the raw 
pmol values for each residue. Values for background and lag are 
calculated for each amino acid and a scoring algorithm is used to 
determine the called amino acid in each residue cycle.

Flow Diagram The following flow diagram illustrates the flow of data for sequence 
calling in the SequencePro software.

Collate Raw Pmol 
Values

Calculate 
Background 

Values

Calculate Lag 
Values

Determine 
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Call Sequence 
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Create Sequence 
Call Table
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Viewing Tables in the Sequence Window

Tables You Can
View

When the Sequence window is open, you can view the following 
sequence data tables using the Sequence Tables window:

Viewing the
Sequence Tables

Window

To view the Sequence Tables window:

1. While the Chromatogram window is open, from the View menu, 
select Sequence Data. The Sequence Tables window opens as 
shown below.

2. To view another table, click a tab in the lower left side of the 
window.

For this table... See page

Using the Sequence Call Table 6-4

Using the User Call Table 6-5

Using the Raw Picomole Table 6-6

Using the Background Corrected Table 6-7

Using the Lag Corrected Table 6-8

Using the Scores Table 6-9
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Changing
Sequence

Window Settings

To change the Sequence Window settings:

1. From the Sequence menu, select Settings to open the Sequence 
Settings dialog box. 

2. Make the changes you want and then click OK.

Using the Sequence Call Table

Description The Sequence Call table contains the collated sequence call values 
for the called amino acid in each residue cycle.

Viewing the
Sequence Call

Table

To view the Sequence Call table:

1. In the Sequence Tables window, click the Called tab to open the 
Sequence Call table.
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For information about changing the table settings, see 
“Changing Sequence Window Settings” on page 6-4.

2. To view another table, click a tab in the lower left side of the 
window.

Using the User Call Table

Description The User Call table contains the collated sequence call values for the 
amino acids in each residue cycle called by the user.

Viewing the User
Call Table

To view the User Call table:

1. In the Sequence Tables window, click the User tab to open the 
User call window.

For information about changing the table settings, see 
“Changing Sequence Window Settings” on page 6-4.

2. To view another table, click a tab in the lower left side of the 
window.

Called tab

User tab
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Using the Raw Picomole Table

Description The Raw Picomole table contains the collated raw picomole values 
for each amino acid identified in the residue cycles.

Viewing the Raw
Picomole Table

To view the Raw Picomole table:

1. In the Sequence Tables window, click the Raw tab to open the 
Raw Picomole table.

For information about changing the table settings, see 
“Changing Sequence Window Settings” on page 6-4.

2. To view another table, click a tab in the lower left side of the 
window.

Raw tab
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Using the Background Corrected Table

Description The Background Corrected table contains the collated background 
corrected picomole values for each amino acid identified in the 
residue cycles.

Viewing the
Background

Corrected Table

To view the Background Corrected table:

1. In the Sequence Tables window, click the Background tab to 
open the Background Corrected table.

For information about changing the table settings, see 
“Changing Sequence Window Settings” on page 6-4.

2. To view another table, click a tab in the lower left side of the 
window.

Background tab
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Using the Lag Corrected Table

Description The Lag Corrected table contains the collated lag corrected picomole 
values identified in the residue cycles.

Viewing the Lag
Corrected Table

To view the Lag Corrected table:

1. In the Sequence Tables window, click the Lag tab to open the 
Lag Corrected table.

For information about changing the table settings, see 
“Changing Sequence Window Settings” on page 6-4.

2. To view another table, click a tab in the lower left side of the 
window.

Lag tab
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Using the Scores Table

Description The Scores table contains the total score values for each amino acid 
identified in the residue cycles.

Viewing the
Scores Table

To view the Scores table:

1. In the Sequence Tables window, click the Scores tab to open the 
Scores table.

For information about changing the table settings, see 
“Changing Sequence Window Settings” on page 6-4.

2. To view another table, click a tab in the lower left side of the 
window.

Scores tab
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Viewing Graph Windows

What Graphs You
Can View

When the Chromatogram window is open, you can view the 
following three graphs in the Graph window:

Viewing the
Graph Window

To view the Graph window:

1. From the View menu, select Graphs to open the Graph window. 

Note: While a graph is displayed, the Graph menu appears on 
the menu bar.

For This Graph See Page...

Using the Amino Acid Yield Graph 6-15

Using the Cycle Yield Graph 6-16

Using the Repetitive Yield Graph 6-17
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2. To view another graph, click a tab in the lower left side of the 
window.

Using the Graph
Window

To use the Graph window:

To... Then...

go from one cycle to the next use the arrow keys on the key 
board.

view another graph click a tab in the lower left side of 
the window.
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Changing Graph
Windows
Settings

To change graph window settings:

1. From the Graph menu, select Settings. The Graph Settings 
dialog box opens to the Data page.

Note: While a graph is displayed, the Graph menu appears on 
the menu bar.

Note: You must check at least one check box for both Amino 
Acids and Residue Cycles.

2. From the Data page, you can take the following actions:

In this 
section... You can click...

Amino Acids either the:

• Individual check boxes that you want to 
appear in the graph.

• All Amino Acids button to select (check) 
all the options.

• No Amino Acids button to deselect 
(uncheck) those options.



DRAFT
September 1, 2005 4:04 pm, Ch_6_View Seq Data.fm

Viewing Graph Windows

SequencePro®  Data Analysis Application v2.1 User Guide 6-13

3. In the Graph Settings dialog box, click the Format tab to open 
the Format page.

Residue 
Cycles

either the:

• Individual check boxes that you want to 
appear in the graph.

• All Residues button to select (check) all 
the options.

• No Residues button to deselect (uncheck) 
those options.

Graph Data the appropriate radio buttons for the graph 
data you want:

• Raw pmols to display the raw picomole 
graph.

• Background pmols to display the 
background picomole graph.

• Lag pmols to display the Lag yield graph.

Graph 
Sequence

either the Called Sequence or User 
Sequence radio button, depending on the 
sequence you want to graph.

In this 
section... You can click...
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4. From the Format page, you can take the following actions:

5. Click the Data tab or click OK.

In this 
section... You can select the...

Title graph title font, the font style and color, and 
the title background color.

Graph graph style, the font style and color, the graph 
background color. You can also click the 
check boxes to show the x- axis and/or the y-
axis grid.

Static legend font, the font style and color, and the 
legend background color.
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Using the Amino Acid Yield Graph

Description The Amino Acid Yield graph displays the amount of each amino acid 
for a selected cycle in picomoles.

Viewing the
Graph

To view the Amino Acid Yield graph:

1. In the Graph window, click the Amino Acid Yield tab to open 
the Amino Acid Yield graph (see “Graph Example” below).

Note: The default graph displays all amino acids for a given 
residue.

For information about changing the graph settings, see 
“Changing Graph Windows Settings” on page 6-12.

2. You can take the following action:

Graph Example The following is an example of an Amino Acid Yield graph.

To... Then...

go from one cycle to the next use the arrow keys on the key 
board.

view another graph click a tab in the lower left side 
of the window.
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Using the Cycle Yield Graph

Description The Cycle Yield graph displays in picomoles the amount of an amino 
acid in each cycle.

Viewing the
Graph

To view the Cycle Yield graph:

1. Click the Cycle Yield tab in the Graph window to open the 
Cycle Yield graph (see “Graph Example” below).

Note: The default graph displays the amount (in picomoles) in 
every cycle for a given residue.

For information about changing the graph window settings, see 
page 6-12.

2. You can take the following action:

Graph Example The following is an example of a Cycle Yield graph.

To... Then...

go from one cycle to the next use the arrow keys on the key 
board.

view another graph click a tab in the lower left side 
of the window.
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Using the Repetitive Yield Graph

Description The Repetitive Yield graph displays in picomoles the amount of the 
called amino acid in each cycle. The calculated average repetitive 
yield is plotted as a straight line.

Viewing the
Graph

To view the Repetitive Yield graph:

1. Click the Repetitive Yield tab in the Graph window to open the 
Repetitive Yield graph (see “Graph Example” below).

Note: The default graph displays the amount (in picomoles) in 
every cycle for a given residue.

For information about changing the graph settings, see 
page 6-12.

2. You can take the following action:

To... Then...

go from one cycle to the next use the arrow keys on the key 
board.

view another graph click a tab in the lower left 
side of the window.
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Graph Example The following is an example of a Repetitive Yield graph.

Graphing User Sequence

Procedure To graph the user sequence:

1. From the Graph menu, select Settings.

The Graph Settings dialog box opens to the Data page.

2. In the Graph Sequence section, click the User Sequence radio 
button and click OK.
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7Customizing Analysis Settings7

About This
Chapter

This chapter describes procedures used to customize analysis settings 
as you work with standard cycles. A flow diagram shows the proper 
sequence to follow to calibrate and edit the settings.

In This Chapter This chapter contains the following topics:

Correcting Calibration Problems. . . . . . . . . . . . . . . . . . . . . . . . . . .7-2

Adjusting the Retention Time Windows . . . . . . . . . . . . . . . . . . . . .7-3

Specifying Reference Peaks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-5

Changing Cycle Integration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-7

Calibrating Standard Cycles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-8
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Correcting Calibration Problems

Correcting
Process

If you find problems with the calibration of the standard cycle, you 
will need to make corrections. 

There are two ways to correct calibration problems:

• Visually inspecting the standard peaks, and then modifying the 
method to correct peak identification and integration of the 
standard cycle

• Correcting peak identification in the standard cycle and copying 
the list to standard peaks to the method

Flow Diagram The following flow diagram illustrates the process of correcting 
calibration problems.

Start Correct 
Calibration

Standard 
Peaks 
Integrated 
Correctly?

Most Peaks 
Integrated 
Correctly?

Change 
Cycle 
Integration

Edit Local 
Events

Done

Standard 
Peaks 
Identified 
Correctly?

Calibrate 
Standard 
Cycles

Adjust the 
Retention 
Time 
Windows

YES

NO

YES
YES

NO

NO

NO

YES

Edit and 
Delete 
Global 
Events

Retention Times
Shifted?
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Adjusting the Retention Time Windows

Description Retention time windows define the time span in which a peak must 
occur in order to be identified as a given component. You can 
compensate for any shifting of the retention times of the peaks by 
widening the retention time window.

Procedure To adjust the retention time window:

1. From the Method menu, select Edit Current.

The Method Editor dialog box opens and the Calibration Table 
tab is displayed.

2. Select the appropriate amino acid from the scroll box on the left.

3. If necessary, enter the new retention time in the Ret Time field 
as shown in step 1above.
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4. Enter the new width of the retention time window:

5. Click OK.

Viewing
Retention Times

To view the retention times on the chromatogram:

1. From the chromatogram window, select Settings. 
The Chromatogram Settings dialog box opens.

2. In the Chromatogram tab Ret. Time drop-down menu, select Off 
or On to specify if the retention time is to appear on the 
chromatogram.

3. Select the check box labeled RT Windows if you want the 
retention time window to appear on the chromatogram.

4. Click OK.

For a... Enter...

constant window width minutes in the Abs Window 
field.

variable window width a percent of the retention time 
in the Rel Window.
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Specifying Reference Peaks

Overview A reference peak, like other single-peak components, has an expected 
retention time and a search window. However, it is usually readily 
identifiable because it is well-separated from other peaks, or because 
it is the largest peak in that region of the chromatogram.

Note: Retention times for peaks can vary widely from run to run. 
Creating an excessively wide retention time window to find these 
peaks may cause windows to overlap. This overlap complicates the 
peak identification process and makes it more difficult to predict the 
peak identifications that the SequencePro® software will make.

Using Reference
Peaks

You can use reference peaks to compensate for shifts in peak 
retention times. Since all peaks shift by the same amount as the 
reference peak, you want to choose a reference peak that appears in 
every cycle, including the standard cycle and all residue cycles. 

Selecting a
Reference Peak

Note: When selecting a reference peak, always choose a component 
that is present in every cycle and shifts in the same general direction 
and time shift as the other peaks in the cycle.

To select a reference peak:

1. In the Method Editor dialog box, click the Calibration Table 
tab.

2. Click on the component you want to use as a reference peak, for 
example, dptu, in the scroll box on the left side.
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3. Click the Ref Peak check box. 

A check mark appears in the check box and the selected 
component is added to the list of reference peaks.

4. Click OK.

Assigning a
Reference Peak

To assign the reference peak to an amino acid:

1. Click on an amino acid in the scroll box on the left side.

2. Select dptu (or another reference) from the Reference pop-up 
menu.

3. Repeat step 1 and step 2 to assign the reference peak to 
additional amino acids.

4. Click OK.
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Changing Cycle Integration 
When you modify integration parameters, you change the way all 
cycles in the sample are integrated.

Modifying
Integration

Parameters

To modify integration parameters:

1. Choose a method to edit:

a. From the Method menu, select Edit Current. The Method 
Editor dialog box appears.

b. Click the Integration tab.

2. In the Peak Detection Parameters section, click on an integration 
parameter.

A description of the parameter appears in text box below (see 
also “Using the Integration Page” on page 4-20 for an overview 
of all the integration parameters).

3. Modify the parameter and then click OK.

All cycles in the sample will be integrated with this 
modification.

Text box
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Calibrating Standard Cycles
When the SequencePro software calibrates the standard cycles, it 
labels all the amino acid peaks and assigns the correct quantity of 
standard present for the recorded height and area.

Select Calibrate from the Analysis menu. 
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8Creating a Report 8

About This
Chapter

This chapter describes how to create, format, specify page layout, and 
save a report of the protein sequencing data.

In This Chapter This chapter contains the following topics:

About Creating a Customized Report . . . . . . . . . . . . . . . . . . . . . . .8-2

About Formatting Chromatograms in the Report . . . . . . . . . . . . . .8-4

About Formatting the Peak Table in the Report  . . . . . . . . . . . . . . .8-7

About Specifying Page Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-9

About Specifying Automatic Printing. . . . . . . . . . . . . . . . . . . . . . .8-9

About Saving the Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-9



DRAFT
September 1, 2005 4:04 pm, Ch_8_Creating Report.fm

Chapter 8 Creating a Report

8-2 SequencePro®  Data Analysis Application v2.1 User Guide 

About Creating a Customized Report

Description You can create a customized report of the protein sequencing data. A 
report consists of the following:

• Sample information

• Sequence call summary

• Chromatograms for selected cycles

Creating a
Customized

Report

To create a customized report:

1. From the View menu, select Report. 

The Report window opens.

2. When the Report window opens, the Report menu is available 
on the menu bar.
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3. From the Report menu, select Settings to open the Report 
Settings dialog box.

4. In the Report Settings dialog box, click the boxes of the 
appropriate items. 

A checked box means that data will appear in the report.

5. Click OK.

6. From the File menu, select Print.
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About Formatting Chromatograms in the Report

Description Use the Chromatogram tab in the Report Settings dialog to format 
how the chromatogram appears in the report.

Formatting
Chromatograms

in the Report

To format chromatograms in the report:

1. While a report is displayed, from the Report menu, select 
Settings to open the Report Settings dialog box.

2. Click the Chromatogram tab.

3. In the Chromatogram section:

Use the... To...

Time Axis and mV 
Axis check boxes

select the parameters that you want to 
appear.

Plot Colors button compare chromatograms.

Line Width text box enter the line width you want for the 
chromatogram.
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4. In the Peak Labels section:

5. In the Integration Events and Baseline section:

Use the... To...

Name pull-down 
menu

select where you want the amino acid 
name to appear (On or Off).

Letter pull-down 
menu

select how you want the amino acid 
name to appear (1- Letter, 3-Letter, or Full 
Name).

Font button select the font for peak labels.

Ret. Time 
pull-down menu

display the retention time above the label 
(On or Off).

Check boxes to select the parameters you want to 
appear in the chromatogram: 

• Baseline
• Drop Lines
• Comments (indicated by yellow box 

above peak in chromatogram view, 
and by footnote in Report view)

• Peak Marks
• RT Windows
• Called Amino Acid

Use the... To...

Events pull-down 
menu

select how you want to indicate the 
events information (Code, Full Text, or 
Off).

Font button select a font, font style, and color, as in 
step 4.
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6. To complete the procedure:

Click... To...

Apply apply the changes to the report. 

Then click OK to save the changes.

OK apply the changes to the report and exit.

The changes are saved.

Cancel exit the dialog box.
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About Formatting the Peak Table in the Report

Description Use the Peak Tables tab in the Report Settings dialog to format how 
the peak table appears in the report.

Formatting the
Peak Table in the

Report

To format the peak table in the report:

1. Once a report is displayed, select Settings from the Report menu 
to open the Report Settings dialog box.

2. Click the Peak Tables tab.

3. In the Peak Table Settings section, you can:

Use the... To...

AA Names pull-down menu select the Full Name, 1-Letter, 
or 3-Letter amino acid 
designation.

Hide Unidentified Peaks check 
box

not display the unidentified 
peaks in the peak table.
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4. In the Peak Table Columns Settings section, you can take the 
following actions:

5. To complete the procedure, you can:

If you want to... Then...

show a column 1. From the Hidden Columns list, select 
the column(s) you want to appear in 
the Peak Tables.

2. Click the <<Show button.

The selected columns appear in the 
Displayed Columns list.

hide a column 1. Select a column(s) in the Displayed 
Columns list.

2. Click the Hide>> button.

The selected columns are deleted from 
the Displayed Columns list.

Click... To...

Apply apply the changes to the report. 

Click OK to save the changes.

OK apply the changes to the report and exit.

The changes are saved.

Cancel exit the dialog box.



DRAFT
September 1, 2005 4:04 pm, Ch_8_Creating Report.fm

About Specifying Page Layout

SequencePro®  Data Analysis Application v2.1 User Guide 8-9

About Specifying Page Layout

Specifying Page
Layout

To specify the page layout:

1. With the Report window open, from the File menu, select Print 
Setup. The standard page setup dialog box opens. 

Note: The appearance of this page will vary with your operating 
system.

2. Select the options depending on what appears in the Print Setup 
dialog box.

3. Click OK.

About Specifying Automatic Printing

Specifying
Automatic

Printing

To set up the report to print automatically after a data analysis is 
complete, do the following:

1. From the View menu, select Preferences. The SequencePro 
Preferences dialog box appears.

2. Click the Acquisition tab.

3. Select the Print Report when Finished check box.

4. Click OK.

About Saving the Report

Saving the Report Once the report is printed, select the Save command from the File 
menu to save it to a file you choose.
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APeak Detection and IntegrationA

About This
Appendix

This appendix provides information about the stages in the peak 
detection and peak integration processes. Information is also 
provided about bunching factors, noise and area thresholds, and the 
twenty-four types of Events that the SequencePro® Data Analysis 
Application v2.1 software supports.

In This Appendix This appendix contains the following topics:

Understanding Peak Detection and Integration. . . . . . . . . . . . . . . A-3

Understanding the Stages in Peak Detection. . . . . . . . . . . . . . . . . A-4

Changing Peak Detection and Integration Parameters  . . . . . . . . . A-8

Establishing a Bunching Factor . . . . . . . . . . . . . . . . . . . . . . . . . . . A-9

Setting the Noise Threshold  . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-11

Setting the Area Threshold . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-12

Understanding Peak Separation and 
Exponential Skim Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . A-13

Using Events . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-17

Using Bunching Factor, Noise Threshold, and 
Area Threshold Events  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-19

Disabling or Enabling Peak Detection (+P/–P) . . . . . . . . . . . . . . A-22

Enabling or Disabling Negative Peak Detection (+N/–N). . . . . . A-24

Inhibiting or Allowing End-of-Peak Detection (+I/–I) . . . . . . . . A-27

Forcing or Discontinuing Common Baseline (+CB/–CB)  . . . . . A-29

Forcing or Discontinuing Valley-to-Valley 
Baselines (+V/–V). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-31

Forcing Baseline to Point (BL) . . . . . . . . . . . . . . . . . . . . . . . . . . A-33

Forcing or Discontinuing Horizontal Baseline 
Forward (+HF/–HF)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-36

Forcing a Horizontal Baseline Backward (HR). . . . . . . . . . . . . . A-40

Using the End Peak Here (E) Event  . . . . . . . . . . . . . . . . . . . . . . A-42

Using the Split/Start Peak (S) . . . . . . . . . . . . . . . . . . . . . . . . . . . A-43

Using Start Manual Integration/End Manual 
Integration (+M/–M) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-45
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Using Force Exponential Skim (+X) Events  . . . . . . . . . . . . . . . A-46

Using Prevent Exponential Skim (–X) Events . . . . . . . . . . . . . . A-47

Tangential Skim (T) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-48
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Understanding Peak Detection and Integration

About Peak
Detection

Peak detection is the process by which the SequencePro software 
examines the raw data points to determine where peaks exist. Peak 
detection consists of four stages:

About Integration  Integration is the process that accomplishes the following tasks:

• Sets the final positions of baselines for peaks

• Determines peak areas

• Adjusts peak areas, if necessary, by using exponential or tangential 
skims

• Calculates peak heights and retention times

 The timed events you set, as well as the parameters in the Integration 
dialog box, affect peak detection and integration. 

For more details, see “Affecting Integration with Timed Events” on 
page A-18.

Peak detection process Stage See Page

“Finding the Potential Peak 
Start”

Begin stage A-4

“Confirming the Peak Start” Confirm stage A-4

“Finding the Peak Top” Find Top stage A-5

“Finding the Peak End” Find End stage A-7
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Understanding the Stages in Peak Detection
In order to use timed events and peak detection and integration 
parameters correctly, you need to be familiar with the stages in the 
peak detection process. The following is an overview of each stage in 
peak detection.

Finding the
Potential Peak

Start

To find the potential start of a peak, the SequencePro software 
examines the difference in value between each bunched data point 
and the preceding one.

A potential peak start point has been found if the difference exceeds 
the current noise threshold value.

Confirming the
Peak Start

How the SequencePro Software Confirms the Peak Start

After the SequencePro software finds a potential peak start, it begins 
to sum the differences between each bunched point and the last 
baseline point. Since each bunched point represents an area slice, the 
sum is the accumulated area for the potential peak, as shown in the 
following example.
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Finding the
Peak Top

Note: The reported retention time for a peak is not simply the time of 
the point identified as the peak top. The reported retention time is 
determined from a quadratic fit based on the three highest data 
points.

How SequencePro Software Finds the Peak Top

The following table lists the process the SequencePro software uses 
to find the top of the peak.

Determining Whether the Peak Start Is Confirmed or Canceled

The peak start will be... If...

confirmed • It passes the area threshold 
test, or 

• The accumulated area exceeds 
the area threshold before a 
bunched point fails the noise 
threshold test.

canceled the differences between bunched 
points must also continue to 
exceed the noise threshold.

To... The software... When...

find the top of the 
peak

first tries to identify a 
local maximum 
bunched point value.

a bunched point is 
lower than the 
previous one, the 
previous point is 
considered to be the 
potential peak top.
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How the SequencePro Software Detects Shoulders

Because of this top-of-peak test, the choice of an area threshold value 
affects both peak confirmation and how shoulders are detected on the 
leading edge of a larger peak. Shoulders on the leading edge of a 
larger peak are not detected as peaks unless they have a discernible 
maximum point and a crest area that is greater than two-thirds of the 
area threshold.

Use the timed event S (split peak) to separate a shoulder that has no 
maximum point as a distinct peak.

avoid finding a false 
peak due to noise

performs a 
confirmation test by 
summing the 
differences between 
the potential top and 
subsequent bunched 
points.

the sum exceeds 
two-thirds of the area 
threshold value the 
potential peak top is 
confirmed.

A higher bunched 
point is found before 
the area test is 
passed, a new 
potential top is 
identified and the area 
test restarted.

To... The software... When...
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Shoulder Not Detected Example

The shoulder is not detected as a peak in the figure below. In the first 
figure on the left, the Area Threshold value is too large. In the second 
figure, the shoulder has no maximum point.

Finding the
Peak End

 There are two indicators of a peak end:

• Two consecutive bunched point differences are less than the noise 
threshold, or

• The start of another peak is detected.

 In either case, the lowest bunched point from the last five bunches is 
considered to be the actual end point of the peak.
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Changing Peak Detection and Integration 
Parameters

Description The Integration command in the Method Editor lets you edit the 
parameters that affect peak detection and integration. 

About Peak
Detection

Parameters

Peak detection parameters are:

• Bunching factor

• Noise threshold

• Area threshold

About Peak
Integration

Parameters

 Peak integration parameters, which are available when you expand 
the Integration dialog box, are:

• Width ratio

• Valley-to-peak ratio

• Peak height ratio

• Adjusted height ratio

• Valley height ratio
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Establishing a Bunching Factor

Bunching Factor
Description

The bunching factor specifies how many sequential data points in a 
raw data file should be grouped in a bunch. During peak detection, 
the SequencePro software counts bunches and averages the voltage 
values of the points in each bunch. The resulting averages are 
assigned to bunched points.

Bunching Factor
Example

The following figure shows how bunching smooths out raw data, 
which helps prevent the SequencePro software from identifying 
baseline noise as peaks.

 

Using the
Bunching Factor

Bunching Factor and Over-Sampling

A bunching factor also compensates for over-sampling, that is, 
collecting more points than are necessary in a peak. Ideally, peaks 
should have about 20 points from start to end. This provides the best 
balance between acceptable processing time and correct peak 
detection and integration.

About the Sampling Rate

The following table lists information about the sampling rate.

Sampling Rate Guidelines  

If... Then...

the sampling rate remains 
constant throughout a run

you may not be able to avoid 
over-sampling because peak 
widths may vary, perhaps 
broadening later in the run.

The broader a peak, the more 
points it is likely to have; thus, it 
may be over sampled.
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Lack of Bunching
Example

Too few bunched data points can smooth small peaks, making them 
invisible to peak detection.

 

The SequencePro software uses bunched data points to identify the 
potential start, top and end of a peak. After finding the potential peak 
values, it reverts back to the raw data points to pinpoint the actual 
peak start, top, and end. Therefore, there is no loss of resolution in 
calculating baseline positioning or peak integration.

both narrow and broad peaks 
occur in the same run

increase the bunching factor one 
or more times by using a timed 
event.

You specify the event (increasing 
the bunching factor) and the time 
in the run when the event will take 
place.

you set the bunching factor too 
high 

this can lead to small, unresolved 
peaks being smoothed out 
completed, so they are 
undetected.

The goal in setting a bunching 
factor by timed event is to 
maintain the number of points 
across the peaks reasonably close 
to the 20-point optimum.

Sampling Rate Guidelines (continued) 

If... Then...
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Setting the Noise Threshold

About Noise
Threshold

The noise threshold (NT) parameter enables the SequencePro 
software to discriminate between baseline noise and peaks. If the 
difference between two consecutive bunched data points is greater 
than the noise threshold, the software recognizes the potential start of 
a peak.

The lower the noise threshold, the more sensitive peak detection will 
be. Conversely, raising the noise threshold decreases sensitivity. If the 
threshold is too high, however, the SequencePro software will not be 
able to detect some peaks.

Setting Noise
Threshold and

the Effect on
Peak Detection

The following table lists examples of setting noise threshold and how 
it affects peak detection. 

If the noise 
threshold is... Then...

low the earlier the peak start is detected, but the later the 
peak end.

The data values at the end taper off to a point that is 
below the noise threshold.

high peaks start and end more abruptly.

A higher noise threshold requires a more abrupt rise 
between data values before a peak start can be 
detected. 

By the same token, the peak end is found sooner as 
differences between consecutive data values quickly 
reach the threshold.

The following figure show how increasing the noise 
threshold affects peaks detection.
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Setting the Area Threshold

About Area
Threshold

Area threshold (AT) is used to discriminate between noise spikes and 
peaks. Expressed in microvolts, this parameter is used after the noise 
threshold to confirm the potential start of peaks that pass the noise 
threshold test.

After passing the noise threshold test once, pairs of bunched data 
points must continue to exceed the noise threshold, and the 
cumulative sum of the bunched area slices on the leading edge must 
eventually exceed the area threshold.

Testing Area
Threshold

The following figure illustrates a peak that passes the area threshold 
test. The sum of the bunched area slices on the leading edge exceeds 
the area threshold, so the peak is detected. 

A peak is confirmed when it passes the area threshold test.

Using Area
Threshold

Higher area threshold values make it harder to confirm a peak, and 
the SequencePro software may not detect smaller peaks at all, 
especially those that appear as shoulders on the leading or trailing 
edges of larger peaks.

A good policy when starting out is to use a low noise threshold and a 
high area threshold. These thresholds maintain a high degree of 
sensitivity in detecting peak starting and ending points, but still 
screens out noise spikes. Refer to Setting Noise and Area Thresholds 
in the “Editing Methods and Results Graphically” help file.

In addition to confirming the start of a peak, the area threshold also 
helps determine the top of a peak.
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Understanding Peak Separation and 
Exponential Skim Parameters

About Peak
Separation and

Exponential Skim
Parameters

The values for Peak Separation and Exponential Skim Criteria 
options have been optimized for normal protein sequencing data. 
Although the Integration page of the Method Editor dialog box 
displays additional parameters, they seldom need to be modified. 

IMPORTANT! Peak Separation and Exponential Skim Criteria 
options should only be modified with caution. If you change these 
parameters without fully understanding the potential consequences, 
you may obtain invalid results.

Determining Peak
Separation

Criteria

Two parameters in the Peak Separation Criteria group box determine 
whether two adjacent peaks will be considered as overlapped or 
separated:

• Width Ratio

• Valley-to-Peak Ratio

This determination affects how the baseline is drawn beneath the 
peaks. A set of overlapped peaks is called a cluster and, by default, 
will share a common baseline. Peaks that are separated will each have 
an individual segment of the baseline.

About Width
Ratio

The Width Ratio is the ratio of the distance between the end of the 
first peak and the start of the second peak to the width of the second 
peak at its base (w). See the figure on the following page. If this ratio 
is greater than the set value, the peaks are considered to be separated. 
Otherwise, they are marked as overlapped.

About Valley-to-
Peak Ratio

The Valley-to-Peak Ratio is the ratio of the height of the valley 
between peaks (v) to the height of the smaller peak (p). 

If this ratio is less than or equal to the set value, the peaks are 
considered to be separated. Otherwise they are marked as overlapped.



DRAFT
September 1, 2005 4:04 pm, A_Peak_Detection.fm

Appendix A Peak Detection and Integration

A-14 SequencePro®  Data Analysis Application v2.1 User Guide 

Using
Exponential Skim

Criteria

The parameters in the Exponential Skim Criteria group box 
determine whether an exponential skim line will be used to calculate 
the area of a child peak eluting on the trailing edge of a parent peak. 

The following table lists when the SequencePro software will not use 
these parameters:

About Peak
Height Ratio

The Peak Height Ratio is the ratio of the baseline-corrected height of 
the parent peak to the baseline corrected height of the child peak. 
This ratio must be greater than the set value for the child peak to be 
skimmed. To disable exponential skimming throughout a run, you 
can set this parameter to its maximum value (1.0e+06).

If an... Then this...

+X timed event is in effect forces an exponential skim under 
all circumstances.

-X timed event is in effect prevents an exponential skim.
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The child peak will not be skimmed if Hm divided by Hd is less than 
the set value for the Peak Height Ratio.

About Adjusted
Height Ratio

The Adjusted Height Ratio is the ratio of the height of the parent 
above its start point to the height of the child above the same point. 
This ratio must be greater than the set value for the child peak to be 
skimmed.

The child peak will not be skimmed if Lm divided by Ld is less than 
the set value for the Adjusted Height Ratio.
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About Valley
Height Ratio

The Valley Height Ratio is the ratio of the baseline corrected height 
of the child peak (Hd) to the height of the valley between the parent 
and child peaks above the baseline (Hv). This ratio must be less than 
the set value for the child peak to be skimmed.

The child peak will not be skimmed if Hd divided by Hv is greater 
than the set value for the Valley Height Ratio.
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Using Events

About Baseline
Timed Events

Baseline timed events alter the way the SequencePro software detects 
and integrates peaks during the run. Therefore, you can use them to 
help maintain consistent results when peak characteristics and 
baseline noise characteristics change. 

About Local and
Global Events

The SequencePro software supports two types of timed events.

Other
SequencePro

Events

There are 24 events available in the SequencePro software. For events 
that appear with both a plus and a minus sign, selecting the positive 
event enables it; selecting the negative event disables it.

Note: Only the first three events (bunching factor, noise threshold, 
and area threshold) have values associated with them.

The following table provides a brief description of each timed event. 
They are described in more detail on pages A-19 to A-48. If you are 
not familiar with how to use timed events to optimize peak detection 
and integration, refer to this topic before starting the procedures.

Timed Event Description

Local Event Added directly to a chromatogram in the chromatogram 
window and apply only to the cycle in which they 
appear. 

Use the Events toolbar to add a Local Event.

Global Event Contained in the method template and applied to every 
cycle in a sequencing run.

Use the Method Editor to add a Global Event.

Timed Events

Event Description Value

BF Set bunch factor to value 1 to 99

NT Set noise threshold to value 1 to 999999

AT Set area threshold to value 5 to 1015

+P Enable peak detection –
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Affecting
Integration with

Timed Events

The following pages summarize how each timed event, or pair of 
timed events, affects the way the SequencePro software detects and 
integrates peaks.

–P Disable peak detection –

+N Enable negative peak detection –

–N Disable negative peak detection –

+I Inhibit end of peak detection –

–I Allow end of peak detection –

+CB Turn on non-forced common baseline –

–CB Turn off non-forced common baseline –

E Force the end of current peak –

S Force start of new peak –

BL Force baseline to current peak –

+HF Force horizontal toward baseline –

–HF Stop horizontal toward baseline –

HR Force horizontal backward baseline –

+M Start manual integration window –

–M End manual integration window –

+V Turn on valley-to-valley baselines –

–V Turn off valley-to-valley baselines –

+X Force an exponential skim –

–X Prevent an exponential skim –

T Force a tangential skim –

Timed Events (continued)

Event Description Value
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Using Bunching Factor, Noise Threshold, and 
Area Threshold Events

Resetting Peak
Detection Values

Using the bunching factor (BF), noise threshold (NT), and area 
threshold (AT) timed events allows you to reset the peak detection 
values. These events take effect at the time they are scheduled: they 
do not work retroactively. 

The following table describes the figure below.

Figure... Shows...

 “A” the current area threshold is low, which enables the 
SequencePro software to confirm the peak before the AT 
event occurs. 

The new area threshold value will not affect the 
confirmation of the peak.

The AT event is scheduled too late to affect confirmation of 
the current peak.

“B” the AT event is scheduled during peak confirmation, so the 
SequencePro software uses the new, larger area threshold 
to determine where the peak actually starts.

In this figure, the new area threshold takes effect.

BA
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Using BF, NT, or
AT

For best results, schedule the BF, NT, or AT timed events on the 
baseline away from peaks.

Example

If you schedule these events at times too close to a transition from 
one peak detection stage to another, detection may differ significantly 
from chromatogram to chromatogram because of small shifts in 
retention time, or random noise. 

Using BF The BF event helps compensate for changes in peak width over the 
course of a run.

Example

In packed-column, isothermal gas chromatography, peaks tend to 
broaden as the run progresses. In these cases, scheduling this event at 
least once can help maintain the ideal 20 bunched points per peak. 
The value set for the bunching factors is the number of raw data 
points averaged together to produce a single bunched point. This 
reduces the effective sampling rate for peak detection.

Using NT The NT event helps compensate for changes in baseline noise. You 
can increase the noise threshold to decrease peak detection 
sensitivity, or decrease the noise threshold to increase sensitivity. 

Example

Suppose the beginning of a chromatogram is noisy because of 
fast-eluting contaminants in the solvent, and this noise diminishes 
later in the run. 

Optimizing Peak Detection

Set the default noise threshold high enough to screen out the initial 
noise, and schedule the NT event to decrease the noise threshold at 
the time when the noise diminishes.
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Using AT The AT event also affects peak detection sensitivity. If you are 
scheduling an NT event to change the noise threshold, you should 
probably schedule an AT event at the same time to change the area 
threshold. 

Example

If you are lowering the noise threshold to gain sensitivity, you want to 
lower the area threshold as well. Otherwise, the SequencePro 
software may not confirm the smaller potential peaks that the lower 
noise threshold allows it to detect. 

Note: Applied Biosystems recommends that you set the area 
threshold to five times the value of the noise threshold.
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Disabling or Enabling Peak Detection (+P/–P)

About Peak
Detection

The pair of timed events +P and –P turn peak detection on and off, 
respectively, allowing you to enable and disable peak detection during 
a run. For example, if valve switching causes noise spikes in the 
middle of a chromatogram, you can schedule a –P event before the 
affected region and a +P event after it to avoid the detection of false 
peaks.

Enabling Peak
Detection

The following table lists what happens if peak detection (+P) is 
enabled in the SequencePro software:

Using +P and –P The following table lists the effects of the +P and –P event. 

If the SequencePro software is... Then...

at the point where it is searching 
for a peak ending point (i.e., after 
the peak crest) when the –P event 
occurs

when the –P event occurs, the 
peak will end at exactly that point, 
and all peak detection will stop.

at any other point in peak 
detection

the process will stop and the 
current peak will not be detected.

This event... Has no effect...

+P unless peak detection has been disabled by a –P event.

–P if peak detection is currently disabled.
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+P and -P
Examples

Example Showing Peaks Without –P and +P Events

Without –P and +P events, the SequencePro software detects 
insignificant peaks (from 35.02 to 39.62 minutes). 

Example Showing With –P and +P Events

With –P and +P events, peak detection is disabled in this region.
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Enabling or Disabling Negative Peak Detection 
(+N/–N)

About Negative
Peak Detection

The pair of timed events +N and –N turn negative peak detection on 
and off, respectively. They allow you to enable and disable the 
detection of negative peaks during a run. By default, the SequencePro 
software detects only positive peaks, so you need to add a +N event in 
order to detect negative peaks. The program will continue to detect 
positive peaks after a +N event takes effect.

The SequencePro software detects a potential negative peak if:

• A bunched data point value decreases from the previous bunched 
point value by more than the noise threshold, and 

• If both points lie below the “theoretical” baseline used to separate 
positive and negative peaks. It also applies the area threshold to 
negative peaks.

Using +N and –N The –N event takes effect immediately if peak detection is in the 
Begin or Confirm stages. Otherwise, it is delayed until the end of the 
current peak is found.

This event... Has no effect...

+N if you schedule a +N event to occur when negative 
peak detection is already enabled.

-N when negative peak detection is enabled.
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+N and –N
Examples

Example Showing Peaks Without +N and –N Events

Without the +N and –N events, the negative peak is not detected, and 
a false positive peak is found.

Example Showing Peaks with +N and –N Events

With the +N and –N events, the negative peak is detected, and then 
negative peak detection is disabled.

Detecting a
Negative Peak

Following a
Positive Peak

To detect a negative peak that follows a positive peak, the 
SequencePro software must determine the baseline point at which the 
positive peak ends and the negative peak begins. The same is true for 
detecting a positive peak that follows a negative peak.

This theoretical baseline is set at the voltage level of the bunched 
point within whose data range the +N event occurs. The theoretical 
baseline is not likely to coincide with actual raw data point values 
when it intersects peaks on the chromatogram, so the SequencePro 
software will use the closest actual data. Positive peaks will be forced 
to start and end on raw data points above this baseline, and negative 
peaks will be forced to start and end on raw data points below this 
baseline. As a result, the areas between the theoretical baseline and 
peak baselines will be excluded from the peak areas. 



DRAFT
September 1, 2005 4:04 pm, A_Peak_Detection.fm

Appendix A Peak Detection and Integration

A-26 SequencePro®  Data Analysis Application v2.1 User Guide 

Finding the
Dividing Line

The following figure shows how the SequencePro software finds the 
dividing line between a positive and negative peak.
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Inhibiting or Allowing End-of-Peak Detection 
(+I/–I)

About End-of-
Peak Detection

The pair of timed events +I and –I inhibit and allow, respectively, the 
stage in peak detection when the peak end is detected. When +I is in 
effect, the SequencePro software does not attempt to determine the 
ending point of a peak. The –I event re-establishes peak detection for 
ending points.

Using +I and –I
Events

Use +I and –I events when isomers of a compound elute as shoulders 
on the trailing side of the main peak, and if you want all isomers to be 
treated as part of the main peak. In this case, you can schedule the +I 
event to prevent the SequencePro software from finding the end of 
the main peak, and schedule the –I event to allow peak end detection 
again after the last isomer. 

+I and –I
Examples

The +I event forces the SequencePro software to remain in the Find 
End stage. The result is that it will neither find a peak end nor detect 
the start of the next peak until the event is switched off. The entire 
chromatogram, from the time of a +I event to the time of a –I event 
will be perceived as part of the same peak.

The +I event takes effect immediately, but has no impact on 
processing until peak detection naturally enters the Find End stage. 
The –I event takes effect immediately, and allows the SequencePro 
software to find the first peak end it encounters, based on the current 
noise threshold.
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Example Showing Peaks without the +I and –I Events

Without the +I and –I events, the peak at 31.58 minutes ends 
naturally, but the shoulder on its trailing edge goes undetected.

Example Showing Peaks with the +I and –I Events

With the +I and –I events, the shoulder is included in the peak.
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Forcing or Discontinuing Common Baseline 
(+CB/–CB)

About Common
Baseline Events

The +CB event causes the software to assign an overlap flag of 1 to 
all peaks that occur while the event is in effect.

Using Common
Baseline Events

The following table lists the how the SequencePro software treats 
peaks during integration if a +CB event is enabled.

Stage Description

1. The SequencePro software treats all peaks as though they are 
clustered, even if they do not meet the criteria for being 
overlapped.

2. The software then draws a common baseline for this series of 
peaks, as shown in the following example.

Event Description

+CB Takes effect at the time it is scheduled and 
applies to the current peak. 

The peak on which the event is located, if any, 
as well as to subsequent peaks.

–CB Discontinues the +CB event.

The SequencePro software continues to 
evaluate each peak against the overlap criteria 
and assigns overlap flags of 0 or 1, as 
warranted. 

This event takes effect immediately and 
applies to the current peak and subsequent 
peaks.
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+CB and –CB
Examples

Example Showing Peaks without the +CB Event

Without the +CB event, each peak has a separate baseline.

Note: Even when the +CB event is in effect, the SequencePro 
software will check the artificial cluster for valleys that penetrate the 
forced baseline. If such valleys are present, it redefines the baseline, 
where necessary, to eliminate penetration.

Example Showing Peaks with the –CB Event

With the +CB event (shown at the far left, below), all peaks share a 
common baseline.
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Forcing or Discontinuing Valley-to-Valley 
Baselines (+V/–V)

About Valley-
to-Valley

Baselines

The +V event assigns an overlap flag of 0 to all peaks that occur 
while the event is in effect. 

Using Valley-to-
Valley Baselines

The following table lists how the SequencePro software treats peaks 
during integration if a +V event is enabled.

Stage Description

1. The SequencePro software treats all peaks as though they are 
resolved, even if they meet the criteria for being overlapped.

2. The software draws an individual baseline for each peak, 
extending from valley to valley.

No peaks are clustered.

Event Description

+V Takes effect at the time it is scheduled and 
applies to the current peak, as well to 
subsequent peaks.

–V Discontinues the +V event.

The SequencePro software resumes evaluating 
each peak against the overlap criteria and 
assigns overlap flags of 0 or 1, as warranted. 

This event takes effect immediately and applies 
to the current peak and subsequent peaks.
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+V and –V
Examples

Example Showing Peaks without the +V Event

Without the +V event, some peaks are clustered, having a common 
baseline.

 

Example Showing Peaks with the +V Event

With the +V event, each peak has its own individual baseline, even if 
it is overlapped.
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Forcing Baseline to Point (BL)

About the
Baseline to Point

Event

The BL event forces the baseline to the start of the current peak. The 
current peak is the one on which the event occurs, or the one that 
follows the event, if it occurs between peaks.

Using Baseline to
Point Events

The following table lists how the SequencePro software treats peaks 
if a BL event is enabled.

Stage Description

1. The BL event causes the SequencePro software to assign an 
overlap flag of 0 to the peak preceding the current peak. 

Result: The preceding peak is treated as though it is resolved 
from the current peak.

2. The SequencePro software terminates the peak cluster at the 
end of the preceding peak by ending the cluster baseline 
there. 

Because the baseline is forced into this position, the baseline 
for the current peak is also forced to start at or near the peak 
start.

If this event occurs when 
peak detection is in the...

Then the baseline is 
forced to start at the...

Begin or Confirm stages bunched point representing 
the data bunch at the 
event’s time.

Find Top or Find End stages starting point of the current 
peak.
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BL Event
Examples

The following table lists examples using the BL event.

The figure below... Shows...

no BL event has been 
scheduled. 

A common baseline has 
been drawn for the two 
peaks because they meet 
the overlap criteria.

the effect of the BL event 
when it occurs during the 
Find Top or Find End 
stages. 

The preceding peak is 
assigned a 0 overlap flag 
and thus has a valley-to-
valley baseline. 

As a result, the baseline of 
the current peak is forced to 
begin at the peak starting 
point.

The table below lists what 
happens if the BL event is 
enabled.

If the BL event is... Then...

not enabled the two peaks are clustered and 
integrated by using drop lines.

enabled a baseline is forced to begin at the 
peak start.
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Repositioning
Theoretical

Baselines

You can use the BL event to reposition the theoretical baseline used 
for negative peak detection when a negative peak and a positive peak 
are contiguous. 

The following table lists where the theoretical baseline is moved in 
relation to where the BL event is placed:

If the BL event is... Then the theoretical baseline 
is...

placed within the negative or 
positive peak

moved to the level of the peak 
start.

outside either peak set at the level of the point within 
whose range the event is 
scheduled.
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Forcing or Discontinuing Horizontal Baseline 
Forward (+HF/–HF)

About the
Horizontal

Baseline Forward
Event

The +HF event projects a horizontal baseline from the time of the 
event to the end of the chromatogram, or until the event is turned off 
by a –HF event. 

During integration, the SequencePro software does not adjust the 
baseline to avoid penetration by valleys (as shown by the valley 
between 43 and 46 minutes in the following example). Thus the 
baseline established by the +HF event always remains horizontal.

+HF and –HF
Examples

Example Showing Peaks without the +HF Event

Without the +HF event, each peak has a separate baseline.

Example Showing Peaks with the +HF Event

With the +HF event, all peaks share a common baseline that does not 
deviate from the horizontal. The –HF event restores normal baseline 
treatment.
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Using the +HF
Event

The following table lists the process of how the +HF event works:

+HF Examples The following table lists examples using the +HF event.

Stage Description

1. The +HF event takes effect at the time the event is scheduled.

The horizontal baseline is projected from the level of the 
bunched point within whose data range the event occurs.

2. In sections of the chromatogram where the +HF event is in 
effect, peaks cannot have starting or ending points below the 
baseline.

3. If the baseline intersects a peak, it is not likely to intersect 
exactly at a raw data point, so the peak starting and ending 
points will usually lie some distance above the projected 
baseline

Result: The area between the projected baseline and peak 
starting and ending points will be excluded from the peak 
area, as shown in the example.

+HF Event Examples

The figure below... Shows...

the peak starting and ending 
points of the +HF event must lie 
above the horizontally projected 
baseline.
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The following table provides information on how the +HF event 
works.

that you must be careful where 
you place the +HF event. 

If the projected baseline is set 
too high, as in this example, 
large areas of peaks will be 
submerged below the baseline 
and, therefore, will not be 
integrated. 

Some peaks may be 
submerged entirely and go 
undetected because the 
SequencePro software removes 
the peak data from the result 
file.

Note: To avoid this problem, 
do not schedule a +HF event on 
a peak: place it on the baseline 
just before the start of a peak.

The following table describes 
using the +HF event.

If... Then...

a +HF event is scheduled at a 
point that is too high on the 
chromatogram

peaks may not be integrated.

a –HF event is scheduled the +HF event is discontinued. 

The SequencePro software 
continues evaluating each peak 
against the overlap criteria and 
assigns overlap flags of 0 or 1 as 
warranted.

the SequencePro software is 
searching for a peak ending point 
when either event is encountered

the current peak will end at the 
event. 

Otherwise, the current peak (if any) 
will be discarded.

+HF Event Examples (continued)

The figure below... Shows...
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Scheduling +HF
and –HF Pairs

You may schedule any number of +HF/–HF pairs in a chromatogram, 
but they must not be overlapped.

If... Then...

two +HF events are scheduled in a 
row, without an intervening -HF 
event

the second event will be ignored.

The lack of an intervening –HF 
event might even prevent the 
SequencePro software from 
drawing a baseline.
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Forcing a Horizontal Baseline Backward (HR)

About the
Horizontal

Baseline
Backward Event

The HR timed event projects a baseline backward from the time of 
the event. The baseline is set at the level of the bunched point within 
whose data range the HR event occurs. The SequencePro software 
does not adjust the baseline to prevent penetration by valleys; thus the 
baseline remains horizontal.

Note: To achieve the best result, you should not schedule the HR 
event on a peak: place it on the baseline between peaks or after any 
peak. This helps avoid baselines that are too high or too low.

Using Horizontal
Baseline

Backward

The following table lists the how the SequencePro software treats 
peaks if a HR event is enabled:

Stage Description

1. Where the HR event is in effect, peaks cannot have starting or 
ending points below the baseline.

2. If the baseline intersects a peak, the intersection is not likely 
to occur exactly at a raw data point. 

Therefore, the peak starting and ending points will usually lie 
some distance above the projected baseline. 

As a result, the area between the projected baseline and the 
peak starting and ending points will be excluded from the 
peak area. This result is due to the algorithm in the 
SequencePro software that requires peak boundaries to occur 
at raw data points and not between points.
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HR Event
Examples

Example Showing Peaks without the HR Event

Without the HR event, peaks may have separate baselines.

 

Example Showing Peaks with the HR Event

With the HR event, a common baseline projects backward to the start 
of the chromatogram.
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Using the End Peak Here (E) Event

About the End
Peak Here Event

The E event establishes a peak end at a selected point. You can use 
this event in conjunction with the +I and –I events to ensure that a 
peak ends at the desired point.

Scheduling the
End Peak Here

Event

The following table lists scheduling an E event:

E Event
Examples

Example Showing a Peak without the E Event

Without the E event, the peak end is found automatically.

 

Example Showing a Peak with the Event

With the E event, the peak end is set arbitrarily.

 

If the SequencePro software is... Then the...

in the Begin or Confirm stages at 
the time the E event is scheduled

event will have no effect.

not in the Begin or Confirm stages 
at the time the E event is 
scheduled

last point of the current bunch 
becomes the ending point. After 
this event, the SequencePro 
software re-enters the Begin 
stage.
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Using the Split/Start Peak (S)

About the
Split/Start

Peak Event

The S event starts a new peak at the time when the event occurs, 
regardless of whether a peak would normally be detected and 
confirmed at this position. This event is typically used to force 
shoulders to be split from the parent peak, as shown in the following 
example.

Scheduling
Split/Start Peak

Events

The following table describes scheduling an S event:

If the SequencePro software is... Then...

in the Begin or Confirm stages at 
the time the S event occurs

the Last raw data point of the 
current bunch (located at the time 
the event is scheduled) becomes 
the peak starting point. 

Also, the SequencePro software 
enters into the Find Top stage.

at the Find Top stage when the S 
event is scheduled

it forces the present peak to end 
on the last point of the current 
bunch, and a new peak is forced 
to begin.
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Split/Start Peak
Event Examples

Example Showing Peaks without the S Event

Without the S event, the shoulder on the peak at 31.58 minutes is not 
detected as a separate peak.

 

Example Showing Peaks with the S Event

With the S event, the shoulder is detected and split off.
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Using Start Manual Integration/End Manual 
Integration (+M/–M)

About Manual
Integration

Events

The timed events +M and –M allow manual integration of peaks. 
Manual integration of peaks may be required if you want to start a 
peak’s baseline at a particular point.

Using the Manual
Integration

Events

The following table lists where to place the +M/–M events:

Place the... The SequencePro software 
will...

+M event where you want a peak's 
baseline to start

draw the baseline between the 
points on which the events have 
been placed. 

If they are not placed exactly on 
two points, the SequencePro 
software will connect the points 
within whose area the events are 
positioned. 

Each point represents an area 
slice extending backward from the 
point to the preceding point.

–M event at the end of the 
baseline
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Using Force Exponential Skim (+X) Events

About Force
Exponential Skim

Events

To ensure that the SequencePro software creates an exponential skim, 
schedule the +X event anywhere within the parent peak on which you 
want the skim to start.

Knowing When
+X Will Have No

Effect

The following table lists when the +X event will have no effect or 
when it will not work:

Using the +X
Event

The following table lists how to use the +X event:

The +X event will... If...

have no effect unless you place it between the 
starting and ending points of a 
peak.

not work placed on the baseline outside a 
peak.

If you... Then...

schedule more than one +X event 
on the same peak 

only one event will be recognized.

place +X events on two adjacent 
peaks in the same cluster

the SequencePro software will 
ignore the first one because it 
cannot decipher multiple skims 
when they converge.

place +X events on nonadjacent 
peaks in the same cluster

the SequencePro software will 
draw exponential skims. 

However, what is drawn from the 
first peak will not extend past the 
start of the next peak with a +X 
event.
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Using Prevent Exponential Skim (–X) Events

About Prevent
Exponential Skim

Events

Scheduling a –X event anywhere on a peak ensures that the 
SequencePro software will not create an exponential skim that 
originates on that peak. This event does not prevent the software from 
drawing a skim beneath the peak, if the skim originated on a 
preceding peak.

Knowing When
–X Will Have No

Effect

Note: If you schedule more than one –X event on the same peak, 
only one event will be recognized.

The following table lists when the –X event will have no effect or 
when it will not work:

The –X event will... If...

have no effect not placed between a peak’s 
starting and ending points.

not work placed on the baseline outside a 
peak.
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Tangential Skim (T)

About Tangential
Skim Events

The following table describes how the SequencePro software creates 
a tangential skim:

The example below shows peaks before and after a tangential skim.

 

Adjusting Peak
Areas

To adjust peak areas by using a tangential skim, use a T timed event. 
Unlike an exponential skim, the SequencePro software never creates 
a tangential skim automatically.

Stage Description

1. The SequencePro software draws a straight baseline from the 
starting point to the ending point of each child peak of a 
designated parent peak, as shown in the following example.

Such baselines are drawn for each child peak that occurs 
before the end of the cluster.

2. The software checks to see that the new baselines are not 
penetrated by the child peaks.

3. New areas for the child peaks are calculated, and the 
difference between the old and new areas (the area between 
the tangent baselines and the cluster baseline) is added to the 
parent peak.
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Knowing When T
Will Have No

Effect

The following table lists when the T event will have no effect or when 
it will not work:

Scheduling More
Than One T Event

The following table describes scheduling T events:

The T event will... If...

have no effect not placed between a peak’s 
starting and ending points.

not work placed on the baseline outside a 
peak.

If you... Then the...

schedule more than one T event 
on the same peak

effect will be the same as having 
one T event.

place T events on two adjacent 
peaks in the same cluster

Note: Avoid scheduling T events 
on more than one peak in a cluster.

the first one will be ignored.



DRAFT
September 1, 2005 4:04 pm, A_Peak_Detection.fm

Appendix A Peak Detection and Integration

A-50 SequencePro®  Data Analysis Application v2.1 User Guide 



DRAFT
September 1, 2005 4:04 pm, B_Warranty.fm

SequencePro®  Data Analysis Application v2.1 User Guide B-1

BSoftware Warranty Information B

This appendix contains the following:

Computer Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-2

Limited Product Warranty. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-2
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Computer Configuration
Applied Biosystems supplies or recommends certain configurations 
of computer hardware, software, and peripherals for use with its 
instrumentation. Applied Biosystems reserves the right to decline 
support for or impose extra charges for supporting nonstandard 
computer configurations or components that have not been supplied 
or recommended by Applied Biosystems. Applied Biosystems also 
reserves the right to require that computer hardware and software be 
restored to the standard configuration prior to providing service or 
technical support. For systems that have built-in computers or 
processing units, installing unauthorized hardware or software may 
void the Warranty or Service Plan.

Limited Product Warranty

Limited Warranty Applied Biosystems warrants that for a period of ninety (90) days 
from the date the warranty period begins, its SequencePro® Data 
Analysis Application v2.1 software will perform substantially in 
accordance with the functions and features described in its 
accompanying documentation when properly installed on the 
instrument system for which it is designated, and that for a period of 
ninety (90) days from the date the warranty period begins, the tapes, 
diskettes, or other media bearing the software product will be free of 
defects in materials and workmanship under normal use. If buyer 
believes that it has discovered a failure of the software to satisfy the 
foregoing warranty, and if buyer notifies Applied Biosystems of such 
failure in writing during the ninety (90) day warranty period, and if 
Applied Biosystems is able to reliably reproduce such failure, then 
Applied Biosystems, at its sole option, will either (i) provide any 
software corrections or “bug-fixes” of the identified failure, if and 
when they become commercially available, to buyer free of charge, or 
(ii) notify buyer that Applied Biosystems will accept a return of the 
software from the buyer and, upon such return and removal of the 
software from buyer's systems, terminate the license to use the 
software and refund the buyer's purchase price for the software. If 
there is a defect in the media covered by the above warranty and the 
media is returned to Applied Biosystems within the ninety (90) day 
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warranty period, Applied Biosystems will replace the defective 
media. Applied Biosystems does not warrant that the software will 
meet buyer's requirements or conform exactly to its documentation, 
or that operation of the software will be uninterrupted or error free.

Warranty Period
Effective Date

Any applicable warranty period under these sections begins on the 
earlier of the date of installation or ninety (90) days from the date of 
shipment for software installed by Applied Biosystems personnel. 
For all software installed by the buyer or anyone other than 
Applied Biosystems, the applicable warranty period begins the date 
the software is delivered to the buyer. 

Warranty Claims Warranty claims must be made within the applicable warranty period.

Warranty
Exceptions

The above warranties do not apply to defects resulting from misuse, 
neglect, or accident, including without limitation: operation outside 
of the environmental or use specifications, or not in conformance 
with the instructions for the instrument system, software, or 
accessories; improper or inadequate maintenance by the user; 
installation of software or interfacing, or use in combination with 
software or products, not supplied or authorized by 
Applied Biosystems; and modification or repair of the product not 
authorized by Applied Biosystems. 

The foregoing provisions set forth Applied Biosystems' sole and 
exclusive representations, warranties, and obligations with respect to 
its products, and Applied Biosystems makes no other warranty of any 
kind whatsoever, expressed or implied, including without limitation, 
warranties of merchantability and fitness for a particular purpose, 
whether arising from a statute or otherwise in law or from a course of 
dealing or usage of trade, all of which are expressly disclaimed.

Warranty
Limitations

The remedies provided herein are the buyer's sole and exclusive 
remedies. Without limiting the generality of the foregoing, in no 
event shall Applied Biosystems be liable, whether in contract, tort, 
warranty, or under any statute (including without limitation any trade 
practice, unfair competition, or other statute of similar import) or on 
any other basis, for direct, indirect, punitive, incidental, multiple, 
consequential, or special damages sustained by the buyer or any other 
person or entity, whether or not foreseeable and whether or not 
Applied Biosystems is advised of the possibility of such damages, 
including without limitation, damages arising from or related to loss 
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of use, loss of data, failure or interruption in the operation of any 
equipment or software, delay in repair or replacement, or for loss of 
revenue or profits, loss of good will, loss of business, or other 
financial loss or personal injury or property damage.

No agent, employee, or representative of Applied Biosystems has any 
authority to modify the terms of this Limited Warranty Statement or 
to bind Applied Biosystems to any affirmation, representation, or 
warranty concerning the product that is not contained in this Limited 
Warranty Statement, and any such modification, affirmation, 
representation, or warranty made by any agent, employee, or 
representative of Applied Biosystems will not be binding on 
Applied Biosystems unless in a writing signed by an executive 
officer of Applied Biosystems. 

This warranty is limited to the buyer of the product from 
Applied Biosystems and is not transferable.

Some countries or jurisdictions limit the scope of or preclude 
limitations or exclusion of warranties, of liability, such as liability for 
gross negligence or willful misconduct, or of remedies or damages, 
as or to the extent set forth above. In such countries and jurisdictions, 
the limitation or exclusion of warranties, liability, remedies or 
damages set forth above shall apply to the fullest extent permitted by 
law, and shall not apply to the extent prohibited by law.
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Index

Symbols
+CB, common baseline A-29 to A-30
+HF, horizontal baseline A-36 to A-39
+I, end-of-peak detection A-27 to A-28
+M, start baseline A-45
+N, negative peak detection A-24 to A-26
+P, peak detection A-22 to A-23
+V, valley-to-valley A-31 to A-32
+X, force exponential skim A-46

A
adding

component to Data Dictionary 4-25 to 
4-26

local event 5-9
local event to the method 5-11
peak columns 2-10, 8-8
sequence to Data Dictionary 4-27

Amino Acid Yield graph, viewing 6-15
analysis, correcting problems

flow diagram, illustrating process 7-2
global events, modifying 5-7
integration parameters, modifying 5-12, 

7-7
local events, modifying 5-9
reference peaks 7-5
reference peaks, specifying 5-5
retention time windows 5-3, 7-3
standard cycles, analysis 7-8

analyzing data files
creating new method 4-5
flow diagram, illustrating process 4-2
methods, description of 4-3

application preferences flow diagram 2-2
area threshold

setting A-12
using to reset peak detection values A-19 

to A-21
axes, setting properties 3-17

B
Background Corrected table, viewing sequence 

data 6-7
baseline timed events, editing A-17 to A-18
billing information. See Customer page, 

viewing
BL, baseline to point A-33 to A-35
bunching factor

establishing A-9 to A-10
using to reset peak detection values A-19 

to A-21

C
calibrating

flow diagram, illustrating process 5-2
standard cycles, procedure 4-14

Calibration Table page, editing 
parameters 4-15 to 4-16

Call Sequence, procedure 4-28
-CB/+CB, common baseline A-29 to A-30
Chromatogram page, settings 2-8
Chromatogram window

axes properties, setting 3-17
changing preference settings 3-8
Context menus, using to change active 

window 3-9
cycle viewing options 3-4
saving view 3-8
scale properties, setting 3-18
split window, using 3-5
tick marks, setting 3-19
viewing options 3-3
zooming options 3-7
See Also Chromatogram page, settings
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Comments page, writing comments 3-26
computer

configuration requirement B-2
system specifications 1-2
technical support for altered 

configuration B-2
Context menus, viewing 3-9

See Also windows
Customer page, viewing 3-25
cycle viewing options 3-4
Cycle Yield graph 6-16
cycles

correcting analysis problems flow 
chart 7-2

correcting calibration problems, flow 
diagram 5-2

editing events in all cycles 4-18 to 4-19
global events, modifying 5-7
integration parameters, modifying 5-12, 

7-7
local events, modifying 5-9
reference peaks, specifying 5-5, 7-5
retention time windows, adjusting 5-3, 

7-3
standard cycles, calibrating 7-8
standard, procedure 4-14

D
Data Dictionary

adding a component 4-25 to 4-26
adding a sequence 4-27
deleting a component 4-26
deleting a sequence 4-28

data files
attaching a Method template 4-11
flow diagram, illustrating process 4-2
Method template, creating new 

method 4-3, 4-5
selecting default folder 2-7

default folder
data file, selecting 2-7
using File Locations page 2-6

deleting
columns 2-11, 8-8
component to Data Dictionary 4-26

global event 5-8
local event 5-11
sequence to Data Dictionary 4-28

E
E, end peak here A-42
editing

events in all cycles 4-18 to 4-19
global event 5-7
integration parameters 4-20
local event 5-11
sample information, using Sample 

page 3-23
sequence calling parameters 4-23 to 4-24
using Method Editor window 4-9, 4-10, 

4-13
enlarging. See Zooming, toolbar button 

descriptions
Events toolbar, button descriptions 2-21 to 

2-23
events, editing, using Global Events 

page 4-18 to 4-19
exponential skim parameters, setting A-13 to 

A-16

F
File Locations, setting options 2-6

G
Global Events page

editing global events 4-18 to 4-19
global events, editing 5-7
graph windows 6-10 to 6-18

Amino Acid Yield graph 6-15
Cycle Yield graph 6-16
graph windows settings 6-12
graphing user sequence 6-18
procedure for viewing 6-10
Repetitive Yield graph 6-17

H
-HF/+HF, horizontal baseline forward A-36 

to A-39
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horizontal axes, setting properties 3-17
HR, horizontal baseline backward A-40 to 

A-41

I
-I/+I, end-of-peak detection A-27 to A-28
installing 1-2
integration

analysis problems, correcting 5-12, 7-7
area threshold, setting A-12
baseline timed events, editing A-17 to 

A-18
baseline to point, forcing A-33 to A-35
bunching factor, establishing A-9 to A-10
changing parameters A-8
common baseline, 

forcing/discontinuing A-29 to 
A-30

end peak here A-42
end-of-peak detection, 

inhibiting/allowing A-27 to 
A-28

force exponential skim A-46
horizontal baseline backward, 

forcing A-40 to A-41
horizontal baseline forward, 

forcing/discontinuing A-36 to 
A-39

integration parameters, editing 4-20
negative peak detection values, 

disabling/enabling A-24 to A-26
noise threshold, setting A-11
peak detection values, 

disabling/enabling A-22 to A-23
peak detection values, resetting A-19 to 

A-21
peak separation and exponential skim 

parameters, setting A-13 to A-16
prevent exponential skim A-47
residue cycles 4-17
split/start peak A-43 to A-44
start baseline/end baseline A-45
tangential skim A-48 to A-49
valley-to-valley baselines, 

forcing/discontinuing A-31 to 
A-32

See Also global events, modifying
integration parameters, modifying 7-7

L
Laboratory page

setting options 2-4
viewing 3-24

Lag Corrected table, viewing sequence 
data 6-8

local events
modifying local events 5-9

log in, regulatory mode 1-4

M
-M/+M, start baseline/end baseline A-45
Method Editor window

description of 4-9
editing current method 4-13
editing existing method 4-10
See Also Method template, attaching to 

current data file
Method template

attaching to current data file 4-11
creating new method 4-5
description of 4-3

Modes, software installation 1-3

N
-N/+N, negative peak detection A-24 to A-26
noise threshold

setting A-11
using to reset peak detection values A-19 

to A-21

O
operating system, specifications 1-2
options

cycle viewing 3-4
split window, using 3-5
viewing 3-3
zooming 3-7
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P
-P/+P, peak detection A-22 to A-23
pages

Comments page, writing comments 3-26
Customer page, viewing 3-25
Laboratory page, viewing 3-24
Sample page, viewing 3-23

parameters
calibration parameters, editing 4-15 to 

4-16
editing using Method Editor window 4-9, 

4-10, 4-13
integration parameters, modifying 5-12, 

7-7
integration parameters,editing 4-20
sequence calling, editing 4-23 to 4-24

passwords, log in 1-4
peak columns, adding 2-10, 8-8
peak detection and integration

area threshold, setting A-12
baseline timed events, editing A-17 to 

A-18
baseline to point, forcing A-33 to A-35
bunching factor, establishing A-9 to A-10
changing peak detection and integration 

parameters A-8
common baseline, 

forcing/discontinuing A-29 to 
A-30

end peak here A-42
end-of-peak detection, 

inhibiting/allowing A-27 to 
A-28

force exponential skim A-46
horizontal baseline backward, 

forcing A-40 to A-41
horizontal baseline forward, 

forcing/discontinuing A-36 to 
A-39

negative peak detection, 
disabling/enabling A-24 to A-26

noise threshold, setting A-11
peak detection values, resetting A-19 to 

A-21
peak detection, disabling/enabling A-22 

to A-23

peak detection, stages of A-4 to A-7
peak separation and exponential skim 

parameters, setting A-13 to A-16
prevent exponential skim A-47
split/start peak A-43 to A-44
start baseline/end baseline A-45
tangential skim A-48 to A-49
understanding peak detection and 

integration A-3
valley-to-valley baselines, 

forcing/discontinuing A-31 to 
A-32

Peak Tables page, setting 2-10 to 2-11
picomole values, collated

background corrected values, table of 6-7
lag corrected values, table of 6-8
raw picomole values, table of 6-6

platform, specifications 1-2
preferences, setting 2-2 to 2-17

Chromatogram page 2-8
File Locations page 2-6
Laboratory page 2-4
Peak Tables page 2-10 to 2-11
Reports page 2-14
Sequence Tables page 2-12 to 2-13
Toolbar Options page 2-16 to 2-17

printing reports, automatic printing of 8-9

R
RAM, specifications 1-2
Raw Picomole table, viewing sequence 

data 6-6
reducing. See Zooming, toolbar button 

descriptions
reference peaks

description of 5-5, 7-5
specifying 7-5

registering SequencePro 1-2
Repetitive Yield graph 6-17
Reports page, setting 2-14
reports, creating

chromatograms, formatting 8-4 to 8-6
flow diagram, illustrating process 8-2
page layout, specifying 8-9
Peak Tables, formatting 8-7 to 8-8
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printing, automatic printing, 
specifying 8-9

procedure 8-2 to 8-3
saving 8-9

residue cycles, integrating 4-17
See Raw Picomole table

retention time window, adjusting
analysis problems 5-3 to 5-4, 7-3 to 7-4
See Also reference peaks, specifying to

S
S, split/start peak A-43 to A-44
Sample page, viewing 3-23
samples

editing sample information 3-23
viewing sample information 3-21

Save Home View, Chromatogram 
window 3-8

saving, reports 8-9
Scale page, using to set scale properties 3-18
Sequence Calling

Amino Acid Yield graph 6-15
Background Corrected table, viewing 6-7
Cycle Yield graph 6-16
flow diagram, illustrating flow of data 6-2
graph windows settings 6-12
graph windows, viewing 6-10 to 6-18
graphing user sequence 6-18
Lag Corrected table, viewing 6-8
procedure for viewing 6-10
Raw Picomole table, viewing 6-6
Repetitive Yield graph 6-17
Scores table, viewing 6-9
Sequence Call table, viewing 6-4
Sequence Calling page, editing 

parameters 4-23 to 4-24
Sequence window 6-3

Sequence Tables page, setting 2-12 to 2-13
sequence tables window 6-3
Sequence window

graph windows, viewing 6-10 to 6-18
graphing user sequence 6-18
Scores table, viewing 6-9
viewing tables 6-3

SequencePro

description of 2-1
flow diagram, illustrating typical 

session 1-9
preferences, setting 2-2 to 2-17
registering the software 1-2
starting the application 1-10

sequences. See Sequence Calling
settings

Chromatogram page 2-8
timeout intervals 1-6

software installation, modes 1-3
specifications, computer system 1-2
split window, using Chromatogram 

window 3-5
standard cycle

correcting analysis problems 7-8
correcting calibration problems, flow 

diagram 5-2
flow diagram, illustrating process 7-2
reference peaks, specifying 5-5

standard cycles, calibrating procedure 4-14
Standard toolbar, button descriptions 2-18
starting application

preferences, flow diagram 2-2
SequencePro application 1-10

T
T, tangential skim A-48 to A-49
Technical support

for computers with altered 
configuration B-2

Tick Marks pages, setting tick mark 
properties 3-19

tile windows, vertically 3-12
toolbars

Events toolbar, button descriptions 2-21 
to 2-23

options, setting 2-16 to 2-17
Standard toolbar, button descriptions 2-18
Window toolbar, button descriptions 2-20
Zoom toolbar, button descriptions 2-19

U
user
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creating new 1-7
inactivating a 1-8
management features 1-3

user sequence, graphing 6-18

V
-V/+V, valley-to-valley baselines A-31 to 

A-32
vertical axes, setting properties 3-17
viewing options 3-3

W
Warranty

exceptions B-3
for computers with altered 

configuration B-2
period B-2

windows
graph windows settings 6-12
multiple windows, organizing 3-10 to 

3-12
split window, using 3-5
toolbar, button descriptions 2-20

Windows, installing SequencePro on 1-2

X
-X, prevent exponential skim A-47

Z
Zooming

options 3-7
toolbar button descriptions 2-19
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